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Overview

Welcome to Top Draw! If you have been using the evaluation version, you already know how powerful

and easy to use the programis. If not, prepare to be pleasantly surprised! With your continued support,
it will just get better.

Top Draw can be used to create a wide range of drawings and diagrams. It may be used in conjunction
with a word processor for creating large documents, or stand-alone for creating small documents or
presentation graphics.

Top Draw can be used for making view graphs, illustrating stories, creating design diagrams, flow
charting, organizational charts, floor plans, cards, newsletters, cartoons, desktop publishing, and more.

Top Draw appeals to people who have never used a draw program before because they can create great
looking pictures with very little practice. It appeals to experienced user's because it provides advanced
features that can be accessed quickly for producing large volumes of professional quality illustrations.

Related Topics:

Copyright Notice

Disclaimer of Warranty
License Agreement

Release Notes

How This Manual Is Organized
Typographical Conventions
How to Contact Top Software



Copyright Notice
Top Draw™
Copyright © 1993, 1994 Top Software™. All rights reserved.

The Top Draw software and User's Guide are the property of Top Software and are copyrighted. Any
unauthorized reproduction in whole or in part is strictly prohibited.



Disclaimer of Warranty

THIS SOFTWARE AND DOCUMENTATION ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO
PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED
OR IMPLIED. BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO
WHICH THIS PROGRAM MAY BE PUT, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE
IS OFFERED. GOOD DATA PROCESSING PROCEDURE DICTATES THAT ANY PROGRAM BE
THOROUGHLY TESTED WITH NON-CRITICAL DATA BEFORE RELYING ON IT. THE USER MUST
ASSUME THE ENTIRE RISK OF USING THE PROGRAM. ANY LIABILITY OF THE SELLER WILL BE
LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



License Agreement

Top Draw is protected under U.S. and international copyright law. This license agreement describes your
rights and responsibilities as a user of this software. "Top Draw" and "Top Software" are trademarks of
Top Software.

Top Draw Evaluation Version supports all features but has a "Sign-On" dialog that requires a button press,
a random "reminder" message on exit, reminder text on printed and clipboard output, and
"UNREGISTERED" appears in the title bar. Top Draw Registered Version supports all features with no
registration reminders. The program "Sign-On" and "About" dialogs will tell you what version you are
running.

Top Draw Evaluation Version is provided to the user for evaluation for 60 days without a license fee. At
the end of the evaluation period, the user must either register the program or stop using it. The
Evaluation Version may be copied freely and distributed to other users provided that no fee is charged.
Anyone distributing Top Draw for any kind of remuneration must first contact Top Software for
authorization. See the file "VENDOR . TXT" for more information about distributor licensing.

Upon paying the registration fee, one copy of Top Draw Registered Version is licensed to the purchaser
for use on one computer at any one time. You must treat the software just like a book. This software
may be used by any number of people and may be freely moved from one computer location to another,
so long as there is no possibility of it being used at one location while it's being used at another.

Related Topics:
Register Dialog



Register Dialog

The first time you run the Registered Version of Top Draw, you will asked to provide a name to
"personalize" your copy. Type your full name in the space provided.



Release Notes
This is Version 1.0b of Top Draw, released 2/10/94.
Related Topics:

New Features in Version 1.0a
New Features in Version 1.0b

New Features to Appear in Top Draw Version 1.1



New Features in Version 1.0a

ASP Member - The author of Top Draw is now a member of the Association of Shareware Professionals.
Required ASP notices have been added.

Smaller Help file - The Help file is now much smaller with the same content. This makes room for future
upgrades!

Text shortcuts - To add text to the selected object, just start typing. Double-click with the Select tool to
switch to the Text Tool and set the text caret location.

New keyboard accelerators - Ctrl+C (Copy Style), Shift+Ctrl+C (Set Style), Ctrl+B (bold), Ctrl+I (italic),
Ctrl+U (underline), Shift+Ctrl+G (Ungroup - was Ctrl+U). Backspace key can now be used to delete
objects and nodes the same as the Delete key.

Main Menu "Help" moved - shifted over from far right corner to match Microsoft conventions, makes it
easier to find.

topdraw.ini moved - to Windows directory to allow running Top Draw directly from CD-ROM.



New Features in Version 1.0b

Bitmap Import - now you can read BMP and PCX files directly into Top Draw (see "List Files of Type" in
the File|Open dialog).

Interruptible Redraw - now you can press the ESC key to interrupt a lengthy screen redraw.

User ID and Key eliminated - in order to simplify order processing for high-volume sales, the User ID
and Key system has been removed.

Fixes - lots of little problems, and some not so little ones, have been fixed.



New Features to Appear in Top Draw Version 1.1

Line Text - just click anywhere and start typing. Then manipulate the line to get rotated text, text on a
curve, and more. Or click on an existing line (even a curved one) and start typing. The text will follow
the line.

Bitmap Export - export bitmaps in BMP or PCX format directly from Top Draw.
Status Line - more information during sizing, moving, and rotating operations.
More - built in textures, symbol sets, clip art, etc.

Fine Tuning - expect a faster, more polished, solid package.



How This Manual Is Organized
This manual contains the following sections:
Introduction

General information, notices, and license agreement. Getting started instructions including how to install,
run, and register Top Draw.

Learning Top Draw

How to learn Top Draw, system overview, and tutorial.

Top Draw Windows

How to use each Top Draw window, and what each one does.

Top Draw Tools

How to use each Top Draw tool, and what each one does.

Top Draw Menus

How to use each Top Draw menu command, and what each one does.
Keyboard Commands

Summary of keyboard commands used for menu shortcuts, text editing, and drawing.
Glossary

Definitions of technical terms.



Typographical Conventions

This font is used for commands: Command
This font is used for screen elements: Window
This font is used for file names: filename. fnt

This font is used for text you type: Text you type

Menu commands are represented as a sequence of menu choices separated by vertical bars:
MainMenu|SubMenu|SubSubMenu
For example, the Open command on the File menu is represented as:

File|Open

The following abbreviations are used for special keyboard keys:
Ctrl The Control key.
Ins The Insert key.
Del The Delete key.
BkSp The Backspace key.

Key combinations are represented as:
Shift1 + [Shift2 +] Key

For example, the following combination is typed by holding down the Shift key while pressing the Ins key:
Shift + Ins



How to Contact Top Software

We want to hear from you if you have trouble when using Top Draw, or if you have ideas about how to
make Top Draw better. We also enjoy receiving submissions to our annual art contest. You can contact
us by:

Mail: Top Software / P.O. Box 1141 / Conifer, CO 80433 / USA

Phone/Fax: (303) 838-0384

CIS E-Mail: 72643,436

Related Topics:
Technical Support
ASP Ombudsman

Feature Requests/General Feedback
Art Contest



Technical Support

Unregistered users are entitled to one free technical support call. Registered users may call as often as
necessary. Please, read all applicable documentation (on-line and/or printed) before calling. All
technical support calls are logged so that we can improve our products. We will ask for some basic
information for our records when you call.

Technical support is provided for:
¢ Fixing problems or incompatibilities discovered during installation (can't get program to run).

¢ Reports of possible bugs, and to find out if there is a work-around (program glitches during
operation).

e Other major problems (program stops running).
Technical support is NOT intended to provide:

¢ Free training on basic program features.

e Artistic advice.

¢ Windows or DOS configuration advice or training.

In order to correct a problem you discover, we must be able to reproduce the problem. Please record the
exact steps necessary to cause the error and the exact wording of any error messages. If at all possible,
be in front of your computer and have Top Draw running when you call. Also, have available the
contents of your CONFIG. SYS, AUTOEXEC.BAT, and WIN. INI files.

To reach Top Software for technical support:

Mail: Top Software, P.O. Box 1141, Conifer, CO 80433, USA
Tel: (303) 838-0384

Fax: (303) 838-0384

CIS: 72643,436

In the UK, contact Nildram Software at:

Mail: Nildram Software, 82 Akeman Street, Tring, Herts, HP23 6AF, UK
Tel: 0442 891331

Fax: 0442 890303

BBS: 0442 891109

CIS: 76004,3436

In French-Speaking Europe, contact WindowShare at:

Mail: WindowShare SARL, B.P. 2078, 57051-METZ cedex 2, FRANCE
Tel: (+33)87 3237 75

Fax: (+33) 87 30 85 57

ClS: 100031,3257

In German-Speaking Europe, contact CDV Software at:

Mail: CDV Software, Neureuterstrasse 37 b, 76185 Karlsruhe, GERMANY
Tel: ++49 (0)-721-97224-0
Fax: ++49 (0)-721-97224-24

ClS: 100022,274



In Scandinavia, contact Pro-Soft at:

Mail: Pro-Soft, Benlose Skel 4 G, DK-4100 Ringsted, DENMARK
Tel: (+45) 53 61 90 42

Fax: (+45) 53 61 93 91

CISs: 100065,1744

Only authorized representatives of Top Software are qualified to provide technical support for Top Draw.
If you have any questions about a particular company's affiliation, please contact Top Software.



ASP Ombudsman

This program is produced by a member of the Association of Shareware Professionals (ASP). ASP wants
to make sure that the shareware principle works for you. If you are unable to resolve a shareware-related
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road,
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe
Mail to ASP Ombudsman 70007,3536.



Feature Requests/General Feedback
How are we doing? Please drop us a line and let us know.

What new feature do you need the most? If you've gotta have it, call us, or print, fill out, and mail in a
completed opinion form (below - print this topic). We may be able to put your special feature in the next
release.

Top Draw v1.0b Opinion Form

1. Overall Rating: ~_ excellent ~_ good _ fair _ poor

2. 1 use Top Draw for:

3. Features I like the best are:

4. Features I think should be changed are:

5. New features I would like to see are:

6. Are you a registered user? Why or why not?

7. General comments:

Other potential buyers would like to know what you think.
May we quote you in our future advertising?  yes _ no

If "ves" checked, please sign below:

Signature: Date

Name:

Address:

Phone:

-- Mail completed forms to: Top Software, P.O. Box 1141, Conifer, CO 80433 --






Art Contest

Submit your best drawing(s) to Top Software on a floppy disk along with a completed contest entry form
(below - print this topic). Winners will be chosen once a year and announced on July 4th. Entries must
be received by May 1st to be considered for the current contest year. The decisions of the judges are
final. All entries become the property of Top Software. Awards will be in cash and will be a function of
total sales (so make sure your friends register!). The minimum awards will be: first place $100, second
place $50, third place $25. This contest is open to registered users only.

Top Draww Annual Art Contest Entry Form

Name:

Address:

Phone:

Drawing File Names:

These drawings are being submitted for the Top Draw Annual Art Contest. | certify that these are original
works, that | am the artist, and | understand that all materials and drawings submitted become the
property of Top Software.

Signature Date

Comments:



Getting Started

System Requirements
Installation

Running Top Draw



System Requirements

Top Draw runs under Microsoft Windows 3.1. It requires about 2 megabytes of free memory under
Windows to run. All distributed files occupy about 2.5 megabytes of disk space. A display resolution of
640x480 (standard VGA) or better is required. Your system must have a Windows supported mouse or
equivalent pointing device. Top Draw works with any printer supported by Windows.

Top Draw will run on any 80386 or 80486 (SX, DX, DX2) or Pentium based computer that runs Microsoft
Windows. For acceptable performance, a 25MHz 80386SX or better CPU is recommended. If you want
to experience the full power of Top Draw, a fast 386DX, 486DX, or Pentium processor and an accelerated
Super-VGA display are best.



Installation

The Top Draw install program takes care of the details of setting up Top Draw on you hard drive. All you
have to do is tell it where the source files are, where the destination directory should be, and where to put
the icon (if you don't like the defaults). Installation involves decompressing and copying the program files
to a destination directory on your hard drive, updating WIN. INI, and creating an icon in the Program

Manager.
1. Insert the floppy disk.
2. Select Run from the Program Manager File menu.
3. Type a:install or (b:install) and press Enter. The Top Draw Install dialog box will appear.
4. Click OK. The install program will show you the amount of free space available on your hard

drive(s). If you don't have enough free space, switch to the File Manager and delete some
unneeded files. Just click OK if you have enough room.

Next you will be prompted for a source pathname. If installing from a floppy in the A: drive, just
click OK. Otherwise, edit the default path name so that it is correct. If installing from a hard
disk or CD-ROM subdirectory, provide a complete DOS pathname, then click OK.

When prompted for a destination pathname, click OK to select the default (C: \TOPDRAW) or type
the drive and directory where the files should be stored.

Install will display the source and destination path names. Verify that the are correct and click
OK. If not, click BACK to go back and correct them. The files will then be decompressed and
copied. The files are described below.

When copying is complete, install will indicate that WIN. INI is about to be modified. These
modifications are described below. Just click OK.

When prompted, select a Program Manager group to place the Top Draw icon in for the list
provided. This can be a new group, any existing group, or none. Click OK to install the icon.

10. Installation is complete. Click OK to read new user information (recommended).

Related Topics:

WIN.INI Modifications

Networks and Multiple Configurations
Top Draw Files

Uninstalling Top Draw



WIN.INI Modifications
The Install program makes a few minor modifications to WIN. INI.

An entry is added in the [Extensions] section so that you can run Top Draw by double clicking on
* _TDR files in the Windows File Manager.

Anew [Top Draw] section is added with the following entries:
e Version=Version number. Used when installing upgrades.

e UserID=User Name. Do not modify.



Networks and Multiple Configurations

If Top Draw is installed on a network server, each user should have their own copy of the Top Draw
configuration files stored in a separate directory.

Server Files User Configuration Files
TOPDRAW . EXE TOPDRAW . PAL

TOPDRAW. HLP ASSORTED.TDS

Sample Drawings (*.tdr) PENS.TDS

On-line documents and forms (*.wri) ARROWS.TDS
TOPDRAW. INI

To specify a directory for a user's configuration files, create a Path=Path Name entry in the [Top Draw]
section of each user's WIN. INI file.

The Path entry in the [Top Draw] section of WIN.INI can also be used by advanced users to maintain
multiple configurations. If there is no Path entry, Top Draw looks for the configuration files in the
directory containing the file TOPDRAW . EXE , except for TOPDRAW. INI which is stored in the WINDOWS
directory.



Top Draw Files

The install program copies a number of files to your hard drive. They are all installed into the same
destination directory. Besides the program and help files, there are a several symbol sets, sample
drawings, and a number of on-line documentation files.

The distributed files are listed and described below:

TOPDRAW . EXE The Top Draw executable.
TOPDRAW.HLP On-line hypertext help.
TOPDRAW. INI Initialization parameters (created when program is run 1st time).
TOPDRAW. PAL The color palette.
ASSORTED.TDS Default shape palette symbols.

SHAPES3D.TDS Three-D shape palette symbols (registered version only)
PENS.TDS Pen symbols - for drawing lines (extra symbols in registered version).

ARROWS.TDS Line ending symbols for arrows (extra symbols in registered version).

HEARTS.TDR
MERGE . TDR

OCEAN.TDR

Sample drawing
Sample drawing

Sample drawing

PINETREE.TDR Sample drawing - used in tutorial

SAMPLER.TDR Sample drawing - fill and texture styles
TOPSTAR.TDR Sample drawing
TOPDRAW.TDR Sample drawing - ad for catalog screen shots
README . WRI "Getting Started" information for new users.

PRESSREL.WRI Press release.
CONTEST.WRI Top Draw Annual Art Contest application form.

OPINION.WRI

PROBLEM.WRI
FILE ID.DIZ

Customer opinion and feature request form.
Problem report form.

BBS ZIP file description
FILES.TXT List of Top Draw files.
VENDOR. TXT

Program Distributor licensing information and application.
Uninstalling Top Draw
If you need to uninstall Top Draw for any reason, all you have to do is:

1. Delete all of the files in the Top Draw directory and delete the directory.

2. Delete the entries added to WIN. INI listed above.

3. Delete the Top Draw icon and group, if created, from the Program Manager.



Running Top Draw

Running Top Draw is like running any other Windows application. You can double-click on the Top Draw
icon in the Program Manager, double-click on any *.tdr (Top Draw) file to start the program with the
clicked-on file loaded, or type in a command line in the Program Manager File|Run dialog.

To exit Top Draw, choose Close in the system menu of the Top Draw window (upper left), or choose
Exit in the Top Draw File menu.

Related Topics:
Running Modes



Running Modes
Top Draw will run in one of two modes depending on whether you have a registered copy of Top Draw:

Evaluation Mode - Provides all of the normal functionality except that the "Sign-On" dialog requires a key
press, registration reminder messages appear occasionally on exit, registration reminder text appears on
printouts and clipboard output, and UNREGISTERED appears in the Title Bar.

Registered Mode - Provides full functionality with no registration reminders. See Registering to order a
registered copy.



Registering

You can place your order for a registered copy of Top Draw by phone, fax, or mail. Prices and other
details are provided in the "Ordering - " topics below. Printable order forms are also provided. Contact
Top Software or one of our authorized international distributors if you have any questions.

Related Topics:

What Is Shareware?

Why Register?

Here's What You Get!
Ordering - USA

Ordering - UK

Ordering - French-Speaking Europe
Ordering - German-Speaking Europe
Ordering - Australia

Ordering - Scandinavia
Other International Orders



What Is Shareware?

Shareware is a distribution method, not a type of software. Shareware distribution channels include
commercial shareware/freeware disk distribution companies, computer bulletin boards, on-line services
and networks, user group libraries, and sharing of programs between friends (hence the name).
Shareware distribution makes fitting your needs easier and helps you avoid costly mistakes because you
have a chance to try software before buying it. Because the marketing expenses are low, prices are low.

If you try a Shareware program and continue using it, you must "register". Not all registrations involve
paying a fee, but most do. With registration, you can get anything from the simple right to continue using
the software you already have to a "registered" version of the program with a printed manual and
additional incentives. Some programs offer several alternatives for varying fees. The license
agreement for the registered version of a program usually restricts copying and distribution, but you can
continue passing along the Shareware version.

Note that the fee paid to a disk distributor is for copying the disk, shipping, handling, and other expenses.
You have paid for the disk, but not the software on it. Similarly, if you download a program, paying for
connect time fees and phone bills does not constitute payment for the software. The registration fee is a
separate payment, usually paid directly to the author, that is made once you have decided that the
software meets your needs. Shareware has the ultimate money-back guarantee -- if you don't use the
product, you don't pay for it.

Shareware authors are accomplished programmers, just like commercial authors, and the programs are
of comparable quality. In fact, many successful shareware programs are now available through regular
retail stores and catalogs. In both cases, there are programs that meet your needs, and those that don't.
Since sales depend on your satisfaction with the program before you buy, Shareware authors can't
depend on advertising hype or impulse buying.

Shareware authors usually provide technical support. As with large software companies, the quality of
support varies. Unlike large software companies, it is not unusual to be able to talk directly with the
Shareware author for technical support, problem reports, and new feature requests. Because shareware
companies are usually smaller, they can often be more responsive to requests for special features.

Federal and international copyright laws apply to Shareware just as they do to commercial software. The
copyright holder extends specific rights to users and distributors as stated in a license agreement  The
author grants specific rights to individuals and corporations to copy, distribute, and evaluate the software
so that Shareware distribution can happen. License agreements vary, so be sure to read the license
agreement that accompanies your program.




Why Register?

Here are a few good reasons:

1.

® N o g bk~ 0w D

9.

10.
11.
12.

To bypass the sign-on message without a key press.

To get rid of "reminders" in the program title bar and when you exit the program.
To get rid of "reminder text" on printouts, clipboard output, and exported files.
To get additional pens, arrow heads, symbol sets, and clip art.

To get full technical support.

To get a printed manual (optional).

To get the latest version of the program, which may have new features that you need.
To get program upgrade notices.

To get our newsletter containing tips, tricks, contest, and company information.
To be able to convert existing drawings if the drawing file format changes.

To be eligible to enter our annual art contest.

It's the right thing to do.



Here's What You Get!

When you receive the Registered Version, you will get:
1. The newest version of Top Draw, which may contain extra features you don't have.
Additional pens, arrows, and a 3D shapes symbol set.

A printed User's Guide (optional). 150+ pgs. B&W. Lay-flat binding. Same information as on-
line help.

4. Full technical support.
5. Our newsletter, which contains information you need to make the most of Top Draw.
6. More! Call for additional details.

Note: Due to the time delays inherent in shareware distribution, this offer and product prices may change
without notice.



Ordering - USA

To print this form, choose Print Topic in the Top Draw Help File Menu.

¢ Mail Orders: Top Software / P.O. Box 1141 / Conifer, CO 80433 / USA
¢ Phone/Fax Orders: (303) 838-0384
¢ CIS: 72643,436

TOP DRAW ORDER FORM
Name
Company
Address
City State Zip Code
( ) -
Phone
Quantity Description Price Amount
Top Draw 1.0b Registration (disk only) $39.95
Registration with Printed Manual $59.95
Subtotal
Sales Tax
(Colorado Residents 3.8%)
Shipping & Handling
($3 US, $4 Candada & Mexico, $6 Other International)
TOTAL ORDER
Payment Method
__ Cash
___ Money Order
___ Check - Payable to Top Software
___ VISA
__ Mastercard
T Tt /l____
Credit card number Expires
Date

Signature (as shown on credit card)

My shareware copy came from:







Ordering - UK

To print this form, choose Print Topic in the Top Draw Help File Menu.

¢ Mail Orders: Nildram Software / 82 Akeman Street / Tring / Hertfordshire / HP23 6AF
¢ Phone Orders: 0442 891331

e Fax Orders: 0442 890303

e BBS: 0442 891109, CIS: 76004,3436

TOP DRAW ORDER FORM
Name
Company
Address
Phone
All prices in pounds sterling. Prices include shipping/handling.
Quantity Description Price Amount
Top Draw 1.0b Registration (disk only) 34.00
Registration with Printed Manual 49.00
Subtotal
VAT (17.5%)
TOTAL ORDER
Payment Method
___ Cash
___ Postal Order
__ Cheque or Eurocheque - Payable to Nildram Software
__ VISA
___ Mastercard
e /
Credit card number Expires

Signature (as shown on credit card)

My shareware copy came from:







Ordering - French-Speaking Europe

To print this form, choose Print Topic in the Top Draw Help File Menu

TOP DRAW ---- LICENCE d'UTILISATION
(Les sociétés peuvent nous consulter pour des licences multipostes ou des licences multiples)

Remplacez le soulignement par les renseignements demandés.
Imprimez cette fiche, et adressez le tout avec votre réglement a :

WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France

Fax:(+33)87 32 37 75
Vox:(+33)87 30 85 57
Minitel 3615 WinShare
Boutique Licenseware

Nom et Prénom

Adresse

Code Postal et Ville

TOP DRAW disponible en deux versions
1 TOP DRAW sans manuel en anglais : 357 FF

2 TOP DRAW avec manuel en anglais (150 pages) : 476 FF
Prix TTC (pour chaque poste), TVA (18,6 %) et port compris

Nombre de licences : Version (1 ou 2)
Disquette : 3 1/2" 5 1/4" Date
Total TTC (TVA 18,6 % incluse, port compris) FF

Paiement par cheéque (bancaire ou postal), Eurocheque, mandat-lettre,
ou carte bancaire (barrer la mention inutile).

Carte bancaire, indiquez ici les 16 chiffres et la date d'expiration.

Exp.

Signature

Merci de respecter le principe du shareware.






Ordering - German-Speaking Europe

To print this form, choose Print Topic in the Top Draw Help File Menu.

Unsere Anschrift:  CDV-Software Tel. ++49 (0)-721-97224-0
Neureuterstrasse 37 b FAX  ++49 (0)-721-97224-24
76185 Karlsruhe
GERMANY

Menge Produkt Preis Gesamt

Top Draw Vollversion 129.-DM DM
(Neuste Version, Auslieferung erfolgt
auf 3 1/2" HD Disketten, inklusive Handbuch)

Versandart (Zutreffendes bitte ankreuzen!)

[ 1 Nachnahme Inland 10-DM DM
Ausland 30-DM DM
[ 1 Kreditkarte Inland 10-DM DM
Ausland 15-DM DM
[ TAMEX, [ ]VISA, [ ]JEURO/MASTER
Kartennummer - - -
Ablaufdatum : -
[ 1 Lastschrift Inland (ACHTUNG NUR INLAND MOGLICH) 5-DM DM
Bankinstitut
Bankleitzahl
Kontonummer

Abbuchungserlaubnis hiermit erteilt,

Ort, Datum, Unterschrift
Total DM
Anschrift :

Name, Vorname

Firma

Strasse, Hausnummer :
PLZ, Ort

Land

Telefonnummer
FAX-Nummer

Vielen Dank fiir Inren Auftrag und viel Spal} mit diesem Super-Programm...
Ihr CDV-Team




Ordering - Australia
To print this form, choose Print Topic in the Top Draw Help File Menu.

¢ Mail Orders: BUDGETWARE / P.O. Box 496 / Newtown NSW 2042 / AUSTRALIA
¢ Phone Orders: (02) 519-4233
¢ Fax Orders: (02) 516-4236

TOP DRAW ORDER FORM
Name
Company
Address
Phone
All prices in Australian dollars. Prices include shipping/handling.
Quantity Description Price Amount
Top Draw 1.0b Registration (disk only) $75.00
Registration with Printed Manual $110.00
Subtotal
Sales Tax
TOTAL ORDER
Payment Method
Cash

Postal Order
Check - Payable to BUDGETWARE

__ VISA

___ Mastercard

__ Bankcard

e /
Credit card number Expires

Signature (as shown on credit card)

My shareware copy came from:







Ordering - Scandinavia
To print this form, choose Print Topic in the Top Draw Help File Menu.

¢ Mail Orders: Pro-Soft / Benlose Sel 4 G / DK-4100 Ringsted / DENMARK
¢ Phone Orders: (+45) 53 61 90 42

e Fax Orders: (+45) 53 61 93 91

¢ Postgiro: 4 06 21 40

TOP DRAW ORDER FORM
Name
Company
Address
Phone
All prices in dkr. Prices include shipping/handling and 25% VAT.
Quantity Description Price Amount
Top Draw 1.0b Registration (disk only) 387,50
Registration with Printed Manual 562,50
Subtotal
COD (22,50 dkr extra)
TOTAL ORDER
Payment Method
___ Cash
__ Postgiro
__ Check Payable to Pro-Soft
COD

Vy shareware copy came from:




Other International Orders
e Send your order to Top Software (see USA ordering instructions).
¢ Shipping/Handling: $4 Canada/Mexico, $6 Other International.
e VISA/Mastercard provide the most convenient payment method.
¢ Due to the high fees charged by US banks to process non-US checks, all checks must be in US $
drawn on a US bank.




How to Learn Top Draw

Learning how to use all of the features of a new program can be a challenge. Several approaches are
available for learning Top Draw.

You can learn most of the basic features of Top Draw by just using it. Top Draw provides immediate
visual feedback for commands so that it extremely easy to figure out what a command does. It is equally
easy to know what options are currently set. We call this "learning by doing".

One of your most valuable resources for learning Top Draw is the context-sensitive on-line Help system.
It is handier than a book when you are looking for information about a particular command because you
can find the information you need much more quickly. If you are not familiar with Windows Help, take a
few minutes now to find out more.

If you would like a guided introduction to Top Draw, the tutorial exercise provided in this section is for you.
It covers all of the main features of the program as you create a drawing. You may want to review the
Top Draw Basics section before starting the tutorial to get a quick overview of Top Draw user interface
and drawing elements.

Related Topics:

Learning By Doing
Using Help



Learning By Doing
When most people get a new program, the first thing they want to do is fire it up and try it out. Go for it!

Most experienced users follow an established pattern when test driving a new application. The following
sequence is recommended:

1. Start the program and open some of the drawing files that came with the program. Use the File|Open
menu command. If you have any questions, click the Help button in the File Open dialog box.

2. Move the mouse around so that it lands on top of each of the "buttons" on the display (don't click yet).
Now look at the text displayed in the Status Line at the bottom of the Top Draw window. It will give you a
brief description of what that button does.

3. Repeat the mouse around exercise, only this time pull down each of the menus and drag the mouse
slowly across each of the menu items. Again, read the brief description on the Status Line.

4. Start experimenting. You can either manipulate objects in an existing drawing, or open a new file and
play around init. Try each of the tools. Experiment with style changes.

5. Use the on-line Help system to find out more about the commands. Spend some time browsing so
you know what is there and how to find it.



Using Help

There are several ways to access the Top Draw Help system. The method you choose depends on what
you want to know.

Related Topics:

The Help Menu

Context Sensitive Help
Dialog Box Help Buttons
Searching the Help Index



The Help Menu

The Top Draw Help Menu provides several entry points into the Help system. Once you have entered
the Help system, you can move around freely using hypertext links, the browse buttons, history buttons,
and by searching the index.
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Context Sensitive Help

Context sensitive help enables you to find information about a command with a single keypress. Position
the mouse over a button or menu choice so that the associated description appears in the Status Line,

then press the F1 key to get detailed help.



Dialog Box Help Buttons
Most Top Draw dialog boxes have a Help button. Click on it to find out how to use the dialog box.




Searching the Help Index

Searching the Help index is a lot like using the index of a book, only the process is automated. It is one
of the more frequently used methods for finding information.

Click on the Search button in the Help window to bring up the Search dialog box.  Try typing different
words associated with the topic you have in mind. When you find a match, click on the Show Topics
button in the Search dialog box, choose a topic from the list provided, then click on the Go To button to
jump to the associated help topic.



Top Draw Basics

The section provides a quick introduction to the components of the Top Draw screen,
box features, and elements of a drawing.

Related Topics:

Screen Layout
Dialog Box Conventions
Drawing Elements

common dialog



Screen Layout

The figure below shows a typical Top Draw screen and gives the names of the components:
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The Title Bar displays the name of the program and the file name of the current drawing. The Title Bar
also contains the usual Control Menu button (left) and minimize/maximize/restore buttons (right).

Menu Bar

The Menu Bar contains the program main menu. The Top Draw main menu is organized according to
standard Windows conventions. You will find common operations in the usual places.

Style Bar
The Style Bar provides quick access to style setting commands, and displays current style settings.

On the left, the text style group displays and allows setting of character font, size, and style, line spacing,
and horizontal alignment.

In the center, the object style group provides quick access to object style commands. It also displays and
allows setting of object colors using the color palette.

On the right, the Line Sample and Fill/Texture Sample show the current object style settings. The scroll
bar next to the Line Sample enables quick changes to line thickness.

Tools
The Top Draw tools are used for a wide variety of interactive operations:
Select Tool Used to pick drawing objects to be used with menu commands,
and to move, size, rotate, skew, and stretch objects.

Node Tool Used to pick nodes to be used with menu commands, to pick
locations for new nodes and line breaks, and to move nodes.

T Text Tool Used to create new text objects, to add text to an existing object,
and to edit existing text.

Draw Tool Used to draw all kinds of lines: freehand and straight, single- and
multi-segment, open and closed, polylines and Bezier curves.



Shapes Tool Used to add pre-defined shapes to the drawing, and to access the
shapes palette. The Shapes Tool button displays the currently
selected shape in the current style, so it is not always a square.

:I Notes Tool Used to create Notes. Notes can be shown/hidden as a group,
and note text can be printed on a title page with the drawing.

Zoom Buttons Three buttons: Zoom In, Zoom Out, and Zoom to Standard Size.

~
ﬂj Layer Buttons Used to move up/down through the layers of a drawing.

Drawing Window

The Drawing Window consists of Rulers, Scroll Bars, and the drawing itself. The printable page is
displayed as a white rectangle. There can be multiple open drawings. Each drawing has its own
window. They can be viewed one-at-a-time, as shown above, or several drawings can be viewed at
once.

Status Line

The Status Line displays current zoom scale, mouse position, layer, and selected object information.
When the mouse is on a menu item or a button, the Status Line displays a brief description of the
associated command.



Dialog Box Conventions

A dialog box is a window that allows you to set a number of related options. A dialog box may be
displayed in response to a menu command, a button press, or keyboard input. Top Draw uses over 26
dialog boxes. All are composed of standard buttons, number display/input boxes, lists, and other
elements.

Even though they are used for a wide variety of purposes, dialog boxes all work pretty much the same.
When a dialog box first appears, settings for the current choices will appear as button highlighting,
numbers, text, list element highlighting, samples, etc.

Change options by clicking on buttons, typing in new data, or selecting from a list. When a dialog box
input is disabled, it is "grayed" like a disabled menu choice, and attempts to click on it have no effect.
When you are finished changing options, click OK to cause them to take effect.

Common Top Draw input elements are described in more detail:

Related Topics:

Standard Buttons
Numerical Values
Radio Buttons
Checkboxes

Edit Boxes

Lists

Color Palettes
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Lists

Most Top Draw dialog boxes have OK, Cancel, and Help buttons.

Clicking the OK button exits the dialog and causes the selected
options to take effect.

Clicking the Cancel button exits the dialog and leaves the options
at their original values.

Clicking the Help button provides help on the current dialog box.

Most numerical values are entered using a box like the one on the
left. You can increase the value by clicking on the up arrow,
decrease it by clicking on the down arrow, or you can edit the
value directly.

Most values have limits. When using the arrows, the value will
stop changing when the limit is reached. When you type in a
value, the limit will be applied when you click on something else in

the dialog box.

Radio buttons are used for "one of the above" type options. The
term is a reference to the channel selection buttons on many car
radios. In Top Draw, as in most Windows programs, radio
buttons are represented by circles with a caption to the right as
shown in the example. The current choice is shown by a small
black circle in one of the radio buttons.

Checkboxes are used for "on/off" type options. In Top Draw, as in
most Windows programs, checkboxes are represented by squares
with a caption to the right as shown in the example. When an
option is "on", the checkbox has an "X" in it. When the option is
"off", the checkbox is empty.

Edit boxes contain text that can be edited freely, such as a file
name. Click in the box to set the position of the text caret, then
type new text, use the arrow keys, delete key, backspace key, or
any other standard editing commands.



Regular Lists Edit Boxes . . . .
Several forms of lists are used in Top Draw dialog boxes, and in

Hagular

I the Style Bar. A list can be either "regular" so that you can

e B e always see the choices, or "drop-down" so that you have to click a
I £ down arrow to see the choices. Alist can also have an edit box

paguir B Regsie B associated with it so that you can enter choices not on the list.

Drap-Down Lists These combinations are shown to the left.

Scroll to your choice (if necessary) by using the scroll bars or by
holding down the left mouse button while moving the mouse
cursor past the top or bottom of the list box. Select you choice by

clicking on it.
Color Palettes
]
S| Color Palettes appear in the Style Bar, and in the Color, Line
ENEEE Em Style, Fill Style, and Textures dialogs. The same colors appear
ENEEENEN in the same order in all of them and they all work the same way:

use the scroll bar to find the color you want, then click on the color.

Drawing Elements

Top Draw drawings are composed of a few simple elements. These elements can be combined in an
amazing number of ways. A drawing is a collection of objects (also called shapes). All objects have
Line, Fill, and Texture Styles. Some objects contain text. Some objects are groups of other objects. All
objects belong to a layer and have a front/back position within the layer.

These terms are described in more detail:

Related Topics:

Shapes
Shape Styles
Groups

Text

Text Styles
Notes

Layers



Shapes
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A shape is defined by an outline. An outline can be a polyline, a
Bezier curve, or an ellipse. A polyline is a sequence of connected
straight line segments. A Bezier curve is a sequence of
connected smoothly curving line segments. An ellipse is a
special kind of Bezier curve.

Line segment endpoints are called "nodes". Bezier curve nodes
have "handles" that are used to control the curvature of a line
segment. Ellipse nodes can be edited to create pie slices, arcs,
and chords. Acircle is an ellipse with equal width and height.

If the first and last nodes of an outline are connected, the shape is
"closed". Otherwise, it is "open". Only closed shapes have Fill
and Texture Styles. All shapes have a Line Style.

New shapes are added to a drawing using the Draw Tool, the
Shapes Tool, and the Clipboard. The Draw Tool is used like a
pencil to create entirely new shapes. The Shapes Tool is used
like a set of rubber stamps or templates to create copies of
predefined shapes. The Clipboard is used to paste in objects,
such as bitmaps or metafiles, that were created in other programs.

Once a shape has been created, it can be moved, resized,
rotated, skewed, and stretched using the Select Tool. The nodes
and handles can be edited using the Node Tool.

Bitmaps are a handled a bit differently. Bitmaps are created in a
paint program, such as Paintbrush, and then are copied and
pasted into a drawing via the Windows Clipboard. Bitmaps don't
have any of the usual shape styles, and can only be resized.

Fill, and Texture.
Line Style

The Line Style applies to the object outline. The line style
consists of width, color, dashing, pen shape, and arrow head/tail
settings.

Fill Style

The Fill Style applies to the object interior. It can be nothing,
solid, or one of three gradient (or "fountain") fill styles. Solid fill
has one color, gradient fills have two colors and numerous other
options.

Texture Style

The Texture Style also applies to the object interior. The texture
is drawn on top of the fill. In most cases, the fill can be seen
through gaps in the texture. There are two types of textures:
"Pattern" and "Tile". For pattern textures, you can select from a
variety of line and circle patterns. Tile textures consist of a shape
drawn repeatedly in rows and columns. You can pick from a
variety of tile shapes. Most pattern textures have one color.



Tile textures have two colors.

To set the style of a shape, select the shape (by clicking on it using the Select Tool), then click on the
Line, Fill, or Texture button in the Style Bar, or choose a style command in the Format Menu.




Groups

A group is a collection of objects that act like a single object.
There are two kinds of groups: regular and merged.

AGreup  The Fans In a regular group, all of the grouped objects keep their original

~ styles. The example shows a typical group, and its parts. The
& parts are moved apart for clarity - grouping and ungrouping does
not move the parts.
Four Merged Circles With
Arraw Behind A merged group has a single style, and the outlines of the merged
objects act like a single outline. Merged groups can be used to
create see-through holes, and to make a pattern extend across

multiple shapes.

The Group, Merge, and Ungroup commands are on the Arrange
Menu.

Text

Taxt can e Text in Top Draw is always contained in an object. Textis

placed maidn any

shaps, Tha textwil arranged in lines and paragraphs, just as it is in most word
shapo sulling. processors. Textis indented and lines are wrapped to fit inside
Thers are numerais the container object, as shown on the left. When the container

ghnrnator A shape is changed, the text is automatically updated.

parsgraph aiyle
eptiens!

Text can be added to an existing object by clicking on the object
with the Text Tool. You can also use the Text Tool to create an
invisible rectangle to contain new text by pressing the left mouse
button at one corner, dragging to the opposite corner, and
releasing the mouse button. You can change the shape styles of
this rectangle just like any other.

Text Styles
Text styles are grouped into Character and Paragraph styles:

Character Style

A Character Style includes: font, siz€, width, spacing, bold, italic, underline, strikeeut, superscript,
subscript, and color.

Paragraph Style
A Paragraph Style includes: horizontal and vertical alignment, indentation, line spacing, paragraph
spacing, and container top/bottom spacing.



Notes

e OOl T Notes are just like regular text, but with a few special properties:

tazi, but ihoy have s fow
special properties.

¢ Note text can be printed on the title page when a drawing
They are like thase sticky iS printed.

paper things, but are casier
b ke And mane paweril,

¢ Notes can all be shown/hidden together.
¢ When a new note is created, it has a yellow rectangle

instead of invisible one. You can change the style of this
rectangle.

e When a Note is selected, the Status Line indicates that the
object contains a Note.

e The Notes Tool won't work on regular text, and the Text
Tool won't work on Note text.

Layers
Back Front Drawing X . i
A layer works like a transparent sheet of plastic on which part of

the drawing is drawn. Layers can be used to control how much of
the drawing is viewed/edited at a time. A drawing can have any
number of named layers. A new drawing has one unnamed layer.

Hawers Each object in a drawing has a front/back position in a layer as

well as a vertical/horizontal position in the drawing. New objects
are placed at the front of the current layer.

When a drawing is redisplayed, the layers are drawn from back to front. The objects within each layer are
also drawn from back to front. Objects in front may hide part or all of objects in back.

Layers are created and arranged using the Format|L ayers command. The forward/back position of
objects is changed using the Forward / To Front / Backward / To Back commands in the Arrange Menu.

Since it is unusual for all objects in a drawing overlap, it is not always possible to tell what the relative
front/back positions are. Multiple Forward / Backward commands may be needed to get the selected
object to move in front of or behind some overlapping object.



Tutorial Exercise

In this exercise, you will be creating a new drawing similar to the one below. Feel free to make you
drawing look different, but do try to use all of the commands discussed. Try additional options whenever
you feel like it. Have fun!

This exercise should take around 45 minutes, but may take longer if you play around a lot. It does not
cover every Top Draw feature, there are just too many, but it will teach you the skills you will need 90% of
the time. If you haven't read the Top Draw Basics section yet, it would be a good idea to do so before
starting the tutorial.

Let's get started. Start Top Draw by double clicking on the Top Draw icon in the Program Manager.

Note: You can switch quickly between Top Draw and Help as follows:
1. Hold down the Alt key.
2. Type Tab until the icon for the application you want appears.
3. Release the Alt key.
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Related Topics:

Page Setup

Drawing Mountains
Drawing with Layers
Drawing a Forest
Drawing a Pond
Drawing a Cabin

ABit o' Text

Earth and Sky

What have you learned?




Page Setup

First, setup the page in the landscape (sideways) orientation:
1. Perform the Format|Page Setup menu command. The Page Setup dialog will appear.
2. Click the Landscape button.

3. Click the OK button.

The Top Draw window should be maximized, i.e., it should take up the entire screen. If necessary, click
the up arrow at the far right hand corner of the Title Bar to maximize it.

Now click the middle Zoom Button to make the drawing page just fit inside the rulers.



Drawing Mountains

To start the drawing, you will draw three triangular mountains as
shown to the left, then edit them to create a more natural
appearance.

Starting with large background objects helps establish the overall
layout of the drawing. Unlike working with real paint, or bitmap
oriented paint programs, it is not necessary to draw back to front.
In fact, you will draw the sky behind the mountains later on.

Using the Shapes Tool

Click twice on the Shapes Tool to bring up the Shapes dialog.
Click twice on the triangle (first shape, second row) to select it as
the current shape. The Shapes Tool will now have a triangle on
it.

Prass

Draw the left mountain follows:

~R 5 1. Move the mouse cursor to the top left corner of the

Reloasa rectangle that the triangle is to fit inside.

2. Press the left mouse button and drag to the bottom right
corner.

3 Release the left mouse button.

The sequence you just performed is the standard way of
specifying a "sizing rectangle". Draw the middle mountain and
then the right mountain the same way. The right mountain will be
on top but, we'll fix that later.

What if mountains are not in the right place or the right size?

Moving an Object

g PR To move an object, do the following:
Drag
" Click on the Select Tool if it is not active.

Prass
Move the mouse cursor over the object.

Press the left mouse button. A dashed outline will
appear.

Drag the outline to the desired new location for the object.

Release the left mouse button.

n}

Resizing an Object

To resize an object, do the following:

Cliek 1. Click on the Select Tool if it is not active.

2. Click on the object you want to resize (move the mouse
cursor over the object, press and release the left mouse
button). The "selection highlighting" will appear as shown
to the left. This is called "selecting the object."
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3. Move the mouse cursor over one of the little black boxes.
The cursor will change from an arrow to a cross-hair.
Use a corner box to change width and height, a middle
box to change either width or height.

4. Press the left mouse button. A dashed outline will
appear, and the mouse cursor will change to a double
arrow.

Drag the outline to the desired size.

Release the left mouse button.

Undoing Mistakes
What if you make a mistake when drawing, moving, or resizing?
To undo the last operation:

1. Perform the Edit|Undo <Operation> menu command.

That's it! <Operation> is a place holder. The Edit Menu will
really show something like Undo Move or Undo Resize.

What if you make two mistakes in row? Just perform the Undo
command twice. In fact, you can undo the last five operations!
Changing Forward/Back Positions
Now put the right mountain behind the middle one:

1. Select the right mountain by clicking on it.

2. Perform the Arrange|To Back menu command.
At this point the drawing should look something like the figure on
the left.
Zooming In and Out

The next step involves some detail work and you will want to be
able to get a close up view of the middle mountain.

To zoom in:

1. Click on the Zoom In Tool (magnifying glass with a "+"
sign). The mouse cursor will change to look like the
Zoom In Tool.

2. Move the cursor to the top left corner of the area you want
to zoom in on.

3. Press the left mouse button.

Drag to the bottom right corner of the area you want to
zoom in on. A dashed rectangle will be drawn around the
area as you drag.

5. Release the left mouse button.
To zoom out:

1. Click on the Zoom Out Tool (magnifying glass with a "-"
sign).
Zoom in any time you need a close-up view, and out any time you
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need to see more of the picture.

Adding Nodes

Mountains are rarely perfect triangles. Next, you will change the
shape of the middle one a little. A triangle has three nodes, one
at each corner. Extra nodes are needed to create a more natural
shape.

To add a node:
1. Click on the Node Tool if it is not active.

2. Click on the object outline where you want to add a node.
The "node highlighting" will appear, and the pink selection
point "+" will appear as shown in the upper figure on the
left.

3. Perform the Node|Add menu command, or type Ins
(Insert key). A new node will appear at the selection point
as shown in the lower figure.

Add two more nodes a little farther down on the same side of the
triangle. Now, move them around to change the shape.
Moving Nodes
To move a node:

1. Click on the Node Tool if it is not active.

2. Click on the object to be edited with the Node Tool. The
node highlighting will appear.

Move the point of the Node Tool over a node.
Press the left mouse button.

Drag the node to the new location. The lines on either
side of the node will move along with the node so you can
see how the shape will be changed.

6. Release the left mouse button.
Move the nodes around until you get a shape that you like.
Change the shape of the other mountains too, if you wish.
Using the Ruler Grid

If the node "jumps around" when you move it, and you can't
position a node exactly where you want, the Ruler Grid is on.
The grid helps when you want to align shapes or nodes, but
makes fine positioning difficult.

To turn the Ruler Grid off:
1. Click on the View Menu.

2. If Snap To Grid has a checkmark by it, the Ruler Grid is
on. Choose the Snap To Grid command to toggle it off.

3. Otherwise, the Ruler Grid is already off.



Setting the Fill Style of an Object

Mountains aren't solid white. For a snow capped coniferous

forest look, set the fill style of the left mountain as follows:
— 1
After '

Before

Select the object to fill by clicking on it with the Select
Tool.

2. Click on the Fill button in the Style Bar, or perform the
Format|Fill Style menu command. The Fill Style dialog
box will appear.

3. Set the Fill Style dialog options to:
Fill Type = Linear, Angle =0
Color 1 = White, Color 2 = Dark Green

4. Click the OK button. The selected object will be redrawn
in the new fill style.

Feel free to experiment with other Fill Style dialog option settings.

Dofaul Styls
P A — Copying the Style of an Object
1 . . .
ey | Fe———— A convenient way to make several objects have the same style is
to copy the style of one object into another. Set the style of the
— other two mountains by copying the style of the left one.
Before .
To copy an object style:
1. Select the object to copy the style from by clicking on it
P with the Select Tool.
Alter

Perform the Edit|Copy Style menu command.

Select the object to copy the style to by clicking on it with
the Select Tool.

4. Perform the Edit|Set Style menu command.

After the first Copy Style you can perform any number of Set
Style commands. The Copy Style command modifies the
Default Style so the style will appear in the Style Bar samples
when nothing is selected, and new objects will have the new
Default Style.

Saving a Drawing to a File

It is a good idea to save work to a file periodically in any
application. Now would be a good time to do so.

To save a drawing to a file:

1. Perform the File|[Save menu command. Since this is a
new file, the Save File As dialog will appear.

2. Select the desired drive and directory, then enter a file
name (e.g. mountain. tdr)

3. Click OK.



Drawing with Layers

Sky
Mounlains
Forest
Foreground

Layer Buttons
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Drawing a Forest

Dirawing 1

Layers let you work on parts of a drawing separately. A layer is
like a clear sheet of plastic on which only part of the drawing
appears. When the layers are viewed together, you can see the
entire drawing. Each layer can be given a name, and the name of
the current layer appears on the Status Line. New objects are
always added to the front of the current layer.

The layer arrangement for the drawing will be as shown to the left.
To setup the layers:

1. Perform the Format|Layers menu command.

2. In the Name column, replace the "<unnamed>" entry with
"Mountains".

3. Click the Insert button three times. There will now be
four layers shown, three of them unnamed.

4. Click the Forward button once to move the Mountains
layer forward one position.

5 Name the other three layers by editing the "<unnamed>"
entries in the Name column.

6 Click the Single Layer radio button in the Edit group
(upper left section of the dialog box). Now you will only
be able to modify objects in the current layer.

7 Click the OK button.

The current layer, as indicated on the Status Line, should be
Mountains. Click the Layer Up button to move to the Forest
layer.

How do you draw an entire forest? One tree at atime. But
trees, especially pine trees, all look pretty much alike. Top Draw
makes it very easy to make multiple copies of an object. In fact,
there are several different ways, and you will get to try each of
them.

Copy and Paste

There is a picture of a tree in the file pinetree. tdr in the Top
Draw directory. Open this file using the File|Open command.

To copy an object from another file:

1. Select the object to copy by clicking on it with the Select
Tool.

Perform the Edit|Copy menu command.

Switch back to your drawing by selecting the drawing
name in the Window Menu.

4. Move the mouse to the point where you want to paste the



tree and click the left mouse button. The pink selection
point "+" will appear where you clicked.

5. Perform the Edit|Paste menu command. The tree will
appear in your drawing.

6. Resize or move the tree, if you wish, using the Select
Tool.

You can create multiple copies of the tree by repeating steps 4, 5,
and 6. Try it a couple of times, but don't make too many trees
yet.

When you Copy an object, it also becomes available for pasting
into other Windows programs via the Windows clipboard. You
can view the clipboard contents by running the Clipboard program
in the Windows Program Manager.

Importing a Picture

If you want to copy all objects in another drawing into the current
drawing, you can do so by using the Import option of the File|

pinetras.idr Open command as follows:
Import 1. Move the mouse to the point where you want the tree to
Drawing 1 appear and click the left mouse button. The pink
gl s selection point "+" will appear where you clicked.
; |l ; 2. Perform the File|Open menu command. The Open File

= dialog will appear.
Find and select the pinetree. tdr file as you did before.
Click on the Import checkbox.

Click OK. The tree will appear at the selection point.

o o M

Resize or move the tree, if you wish, using the Select
Tool.

Importing a drawing also places a copy of it in the Windows
clipboard.

Duplicating an Object

[
"

Befare Once an object is in a drawing, it can be easily duplicated as
Gds follows:
g - 1. Select the object to be duplicated by clicking on it with the
i Select Tool.

After
2. Perform the Edit|Duplicate menu command (or type

Ctrl+D). A duplicate of the selected object will appear,
offset slightly from the original.

3. Resize or move the duplicate, if you wish, using the
Select Tool.

Repeating the Duplicate command duplicates the last new copy.
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Transforming an Object

Another way to duplicate objects is the Arrange|Transform
command. This powerful command can also move, resize, mirror,
skew, and rotate an object with or without creating duplicates.

For this exercise you will create two duplicates, each smaller than
the previous:

1. Select a tree to duplicate using the Select Tool.

2. Perform the Arrange|Transform menu command. The
Transform dialog will appear.

3. Click on the Defaults button. This will reset all options to
their original default values.

Set the Horizontal Move value to 0.5 inches.

Set the Horizontal and Vertical Resize values to 80%.
Click on the Duplicate checkbox.

Increase the Repeat value to 2.

© N o o &

Click the OK button. Two smaller copies of the tree will
appear.

This is a relatively simple example of what the Transform
command can do.

Creating Custom Shapes

The handiest way to add many copies of an existing shape to a
drawing is using the Shapes Tool. In fact, you will use it to
complete the forest. Here's how:

1. Select a tree to add to the Shapes palette using the
Select Tool. Pick one of the larger ones.

Perform the Edit|Copy command.

Click on the Shapes Tool twice to bring up the Shapes
dialog.

4. Scroll down to an empty spot in the Shapes palette and
click on it to select it.

5. Perform the Edit|Replace Shapes dialog menu command.
The tree will appear in the Shapes palette.

6. Perform the Edit|Use Master Style Shapes dialog menu
command. With this option selected, the original shape
style, rather than the current Default Style for the drawing,
is used when creating new shapes.

7. Edit the name field at the top of the Shapes dialog to
change the name from <unnamed> to "Tree".

8. Click on the Tree shape again. The Shapes dialog will
close and the tree will appear on the Shapes Tool button.

Drawing with this new shape works the same as before (press-
drag-release). Complete the forest by drawing more trees with
the Shapes Tool. The result should look something like this:






Drawing a Pond

This part of the exercise will involve freehand drawing and Bezier
curve node editing. You will find out how easy, and how much
fun, Bezier curves are to work with.

The pond should be placed in the Foreground layer, towards the
bottom of the drawing. Click on the Layer Up button to move to
this layer.

Freehand Drawing

Freehand drawing is done with the Draw Tool. The basic
process is:
3. Ralease 1. Frass 1
& Click - . . . .
4 il ] 2. Move the mouse cursor, which will look like a pencil, to a
r starting place on the outline.

Click on the Draw Tool button if it is not already active.

3. Press the left mouse button. You can think of this as
moving the pencil into contact with the paper (sort of).

Move the mouse to draw the outline.

To complete the outline, release the left mouse button and
click it again without moving the mouse.

To make a closed curve, you must end the outline at the start
point. To make an open curve (i.e., just a line), the start and end
points must be some distance apart. The pond should be a
closed curve.

If you mess up, just use the Edit|Undo command and try again.

The Draw Tool can also be used to draw straight lines. You will
get to try this later on in this tutorial.

Closing an Open Curve

What if the shape you drew was just right, except the endpoints
were not quite close enough for Top Draw to automatically close
the curve? There are two ways to fix this:

1. Using the Draw Tool, draw a line between the endpoints.
or

2. Using the Node Tool, select the object, select both
endpoints (hold down the Shift key to select multiple
nodes), then perform the Node|Join menu command.

Smoothing a Bezier Curve

It is sometimes difficult to draw a smooth freehand Bezier curve.
Here are two handy techniques for smoothing a curve:

1. Using the Node Tool, select the object, then select a node
on the object that makes an unwanted corner in the
outline.

2. Perform the Node|Delete menu command, or press the
Delete key to delete the node. Top Draw will
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approximate the corner with a rounded curve.

or

1. Using the Node Tool, select the object, then select a node
on the object that makes an unwanted corner in the
outline.

2. Perform the Node|Attributes menu command. The
Node Attributes dialog will appear.

3. Make sure the Curve Before, Curve After, and Same
Angle checkboxes are checked (click on them if not).

4. Click OK. The line will now pass smoothly through the
modified node.

If you want to add a corner, just add a node and position it as you
have done previously.

Shaping a Bezier Curve

To adjust the shape of a Bezier curve, you can move the nodes,
and you can move the node handles. The nodes are points that
the curve must pass through. The handles control the curvature
near a node - the curve is "attracted" towards the handles.

To make the nodes appeair, click on an object with the Node Tool.
To make the node handles appear, click on a node with the Node
Tool.

A Bezier curve handle may or may not be visible. To make both

handles appear:
1. Select the node that needs handle(s).
2. Perform the Node|Attributes menu command.

3. Set the Curve Before and Curve After checkboxes "on"
and click OK.

To move a node or node handle:
Move the Node Tool over a node or node handle.
Press the left mouse button.

Move to the new location. The connected lines will be
redrawn as you move the node or handle.

4. Release the left mouse button.
Reshape the pond using these techniques to get the desired
shape.
Line, Fill, and Texture Styles
Set the Line, Fill, and Texture Styles of the pond to your liking:
1. Click on the pond shape with the Select Tool to select it.

2. Click on the Line, Fill, or Texture buttons on the Style
Bar, or use the corresponding commands in the Format
Menu. A style dialog box will appear.

3. Experiment with the style options. Click the Help button



in the dialog box if you need more information.
4. Click OK to set the object style.

Repeat steps 2, 3, and 4 for the remaining styles. The object will
remain selected unless you click on something else in the
drawing.

At this point, your drawing should look something like this:




Drawing a Cabin
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Next you will draw a cabin just above the pond. The approach
taken will be rather simplistic, and the results of questionable
artistic merit. But, the intent is to demonstrate some additional
features. With your newly learned skills, you can go back and do
a proper job of it later.

The cabin is all rectangles. The easy way to draw it would be to
select the Rectangle shape in the Shapes Palette, then draw four
rectangles using the Shapes Tool. Just for practice, you will use
the Draw Tool.

Drawing a Rectangle

When drawing a shape with horizontal and vertical lines, it is
usually best to have the shap grid on to make aligning the corners
easier (make sure Snap To Grid in the View Menu is checked).
To draw a rectangle (for the cabin wall);

1. Click on the Draw Tool button if it is not already active.

2. Move the mouse cursor to the location of the first corner
and click the left mouse button.

3. Move to the location of the next corner. A "rubber line"
will appear between the first corner and the mouse cursor
to show where the new line will go. Click the left mouse
button to place the corner.

Repeat Step 3 for the third and fourth corners.

To close the rectangle, move back to the first corner and
click the left mouse button.

6. Click the right mouse button to complete the rectangle.

Now create the remaining rectangles by using the Draw Tool, the
Shapes Tool, or by creating copies of the first rectangle. Move
and size the rectangles until you are satisfied with the
arrangement. Don't worry about styles yet.

Selecting Multiple Objects

The door and window will make see-through holes in the wall.
First, select all three objects (the wall, the door, and the window)
using one of these two methods:

1. Click on the Select Tool button if it is not already active.
2. Hold down the Shift key.
3. Click on each of the three shapes.
or
1. Click on the Select Tool button if it is not already active.

2. Move the mouse cursor to just above and left of the top
left corner of the wall. Position the mouse cursor so that
it is not over any drawing objects.

3. Press the left mouse button and drag to the right and
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down until the dashed box surrounds all three objects.

4. Release the left mouse button.

Making Holes

With the three objects still selected, perform the Arrange|Merge
menu command. The objects will be "merged" into a single
object, and the door and window will be holes. A merged object
can be split apart at any time using the Ungroup command (but
don't do it now).

Setting Styles

Now, set the styles of the roof and the wall. The example has a
solid brown fill, a crosshatch pattern texture on the roof, and a
lines pattern texture on the wall. You can use these styles, or
choose your own.

Making a Group

In order to keep the roof on the cabin, it would be a good idea to
group the wall together with the roof. To do this:

1. Select both the wall and the roof.
2. Perform the Arrange|Group menu command.

Now, the roof and wall will select, move, size, rotate, etc.
together as a single object. Groups can be split apart at any time
using the Ungroup command.

Move and size the cabin using the Select Tool to see how it acts
like a single object. Position the door and window in front of
various background objects to see that you can in fact see through
them.

Text in Top Draw is always attached to an object, and appears
inside of the object to which it is attached. The Text Tool can be
used to create invisible rectangles to contain text using the familiar
press-drag-release technique to specify the rectangle size. Or,
you can simply click on an existing object. Here you will use the
latter method.

To start, find the shape that looks like this in the Shapes palette
and draw one in the Foreground layer of the drawing:

Rotating Objects

The new shape does not look quite like a curly piece of paper.
First, it needs to be rotated about 90 degrees. Rotating an object
is as easy as resizing it:
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Finishing the drawing is left as an exercise for the reader. Here are a couple of suggestions.

Select the object to be rotated using the Select Tool.

2. Move the mouse cursor over a rotation handle (tiny double
arrow at top or bottom center). The mouse cursor will
change to a cross hair when it is over the handle.

3. Press the left mouse button. The mouse cursor will
change to a double headed curved arrow.

4. Move the mouse to rotate the object.
5. Release the left mouse button.
Finish making the object the desired shape by using the Node
Tool to move nodes and node handles.
Adding the Text
To add text to an existing object:
1. If the Text Tool is not active, click on it.

2. Using the Text Tool, click on the object to add text to. A
blinking vertical bar will appear. This is the text caret.

3. Start typing. The usual arrow key, backspace, delete,
and other editing commands are available.

You can modify the text style using the buttons on the left side of
the Style Bar, or the Character and Paragraph Style commands
in the Format Menu.

You can also modify the object style. Simple styles work best if
the text is to be readable. You can make the object invisible by
using the None pen in the Line Style, None Fill, and None
Texture.

Create a big rectangle in the Mountains layer below the mountains and set fill and/or texture styles to
make it look like grass.

Create a big rectangle in the sky layer and use a linear gradient fill to make it look like the sky. Add
clouds, sun rays, or whatever you like.



What have you learned?

Alot! You know how to draw with predefined shapes, draw freehand shapes, select, move, resize, and
rotate objects, undo mistakes, move objects forward and back, zoom in and out, add, delete, and move
nodes, turn the Ruler Grid on and off, change the styles of an object, copy a style from one object to
another, use layers, group and ungroup, and much more.

Some general principles should be noted:

¢ To create a complex shape, it is often a good idea to start with a simple shape and add nodes as
needed.

e Don't worry about making mistakes. Undo is available.

¢ You don't have to get it right the first time. Everything can be changed.

e You can reuse entire drawings, parts of drawings, and create copies of shapes with ease.
e  Save your work often!

This should get you started. To learn even more, remember to use on-line help frequently.






The Title Bar
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The Title Bar displays the application name, and, when the Drawing Window is maximized, the name of
the current drawing file. Like all Windows applications, it provides the standard control menu and
window sizing buttons (see Microsoft Windows documentation for details).
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The Menu Bar is located immediately below the Title Bar. The menu is organized in the customary
fashion for Windows applications, so experienced users will be able to learn the location of common
commands very quickly.
The Menu Bar contains the following menus:
File Create, open, close, save, or print a file
Edit an object (undo, redo, cut, copy, paste...)
View Modify the appearance of this application
Arrange  Arrange objects (forward, back, group, ungroup...)
Format Change style of selected object(s)
Node Manipulate selected node(s)

Options  Set configuration options
Window  Select and arrange drawing windows
Help Get help on using Top Draw

When the current Drawing Window is maximized, the Menu Bar contains the control menu and a resize
button for the Drawing Window.

When all of the drawing windows are closed, the Menu Bar contains only the following menus:

File Open a file or create a new file
Help Get help on using Top Draw

The Style Bar
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The Style Bar provides point-and-click access to numerous style setting commands, and displays current
style settings. The style that is displayed and changed depends on the current selection.

¢ |f an object is currently selected, the Style Bar shows the object styles and Style Bar commands
modify the selected object(s).

¢ [f nothing is selected, the Default Style is displayed and is modified by Style Bar commands.

¢ [f the Text Tool is active and a block of text is selected, the style of the first character in the block is
displayed, and text style changes apply to the selected block of text.

¢ |[f the Text Tool is active and an object is selected but the text caret is not visible, the style of the first
character of text in the object is displayed (if any), and text style changes apply to all text in the selected
object(s).

Related Topics:



Character Style Buttons
Paragraph Style Buttons
Font Selection

Line Style Buttons

Fill Style Buttons
Texture Style Buttons
Color Palette

Line Sample

Fill and Texture Sample



Character Style Buttons

[B] sei The Style Bar Character Style Buttons are used to set the bold,
(1] nane italic, and underline Character Style attributes. The button
[U] undedine positions indicate the current character style.

Paragl'aph Style Buttons

Single Space

The Style Bar Paragraph Style Buttons are used to set the

@ 1112 Space horizontal alignment and line spacing Paragraph Style attributes.

Bl nouvle space If any text in a paragraph is selected, the Paragraph Style is
changed. The button positions indicate the current paragraph
style.

The line spacing buttons set the amount of vertical space between
lines in a paragraph.

= Laft Algned The horizontal alignment buttons set the alignment of lines in a

=a| Centarsd paragraph. Horizontal alignment can be flush left, centered, flush
=| Right Aligned right, or justified (flush left and right). Horizontal alignment is

=] Justiied relative to the borders of the object containing the text.

Font Selection

Drop down lists are provided on the Style Bar for setting the text font and font size. The font name and
size displayed indicate the current text style.

A font name can be selected from the list provided. The font size can either be selected or typed in.
The minimum font size is 4pt. Although there is no set limit on the maximum size, text that is too big too
fit in its container object will not be visible.



Line Style Buttons

Sot Line Style
The Style Bar Line Style Buttons allow you to easily modify Line
Style attributes.
e ¢ To modify the current Line Style using the Line Style dialog, click
Sat &ui Line on the Line button.
LIS:'.E:;T coter ¢ To set line conversion and display options using the Line &

Curve Options, click on the Line/Curve Options button.

¢ To set the line color using the Style Bar Color Palette, click on
the Line Color button. To select a custom color using the Color
dialog, click on it again. The color of this button is the color of the
current Line Style.

Fill Style Buttons

Sot Fill Style
SR The Style Bar Fill Style Buttons allow you to easily modify Fill
RN Style attributes.
[ ¢ To modify the current Fill Style using the Fill Style dialog, click on
SelFill  SetFill the Fill button.

Color 1 Color 2

* To set the first or second fill color using the Style Bar Color
Palette, click on the Color 1 or Color 2 button. To select a
custom color using the Color dialog, click on it again. The color of
these button indicates the current Fill Style colors.

Note: For a Solid fill, only Color 1 is used. For None fill, both
colors are ignored. For all gradient fills, both colors are used.

Texture Style Buttons
St Tewture Style

The Style Bar Texture Style Buttons allow you to easily modify

(Tastue Texture Style attributes.
[ ¢ To modify the current Texture Style using the Texture Style

dialog, click on the Texture button.

Set Texture Set Texiure
Caolar 1 Colar 2

¢ To set the first or second texture color using the Style Bar Color
Palette, click on the Color 1 or Color 2 button. To select a
custom color using the Color dialog, click on it again. The color of
these button indicates the current Texture Style colors.

Note: All tile textures and the crosshatch pattern texture have two
colors. All other pattern textures have one color.

Color Palette

The Style Bar Color Palette is used in conjunction with the Line,
Fill, and Texture Style color buttons on the Style Bar. To seta

+ style color:
HEE *
1. Click on the appropriate style color button if it is not



Line Sample

already active.

2. Scroll until you see the desired color in the color palette,
then click on the color square.

- * The Style Bar Line Sample displays a sample of the current Line

+ Style. The scroll bar on the right side of the sample box can be
used to change the line thickness. Click the up arrow to increase
the line thickness, click the down arrow to decrease it.

Fill and Texture Sample

The Style Bar Fill and Texture Sample displays a sample of the
current fill and texture styles.

The Tool Window

The Top Draw tools are used for a wide variety of interactive operations:

EI

At

EE

Select Tool Used to pick drawing objects to be used with menu commands,
and to move, size, rotate, skew, and stretch objects.

Node Tool Used to pick nodes to be used with menu commands, to pick
locations for new nodes and line breaks, and to move nodes.

Text Tool Used to create new text objects, to add text to an existing object,
and to edit existing text.

Draw Tool Used to draw all kinds of lines: freehand and straight, single- and
multi-segment, open and closed, polylines and Bezier curves.

Shapes Tool Used to add pre-defined shapes to the drawing, and to access the
shapes palette. The Shapes Tool button displays the currently
selected shape in the current style, so it is not always a square.

Notes Tool Used to create Notes. Notes can be shown/hidden as a group,

and note text can be printed on a title page with the drawing.
Zoom Buttons Three buttons: Zoom In, Zoom Out, and Zoom to Standard Size.

Layer Buttons Used to move up/down through the layers of a drawing.

The Drawing Window



Fion b The Drawing Window is where most of the action happens.
Bubol  puprs Since there can be many drawings open at one time, there can be
T Page  Serall many Drawing Windows, one per drawing.
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) Normally the Drawing Window is maximized to give you the
¥ largest possible screen area to work on and you only see one
Brawing Wisduw drawing at a time. However, you can arrange the drawing
windows so that you can see more than one at a time using
normal Windows moving and sizing operations and/or Top Draw
Window Menu commands.

Each Drawing Window consists of a Page, Desktop, Rulers,
Units Button, and Scroll Bars. When the Drawing Window is
not maximized, it also has a Title Bar that contains control menu
and minimize/maximize buttons, and displays the drawing
filename.

Related Topics:

Page
Desktop
Rulers

Units Button
Scroll Bars



Page

The Drawing Window Page represents the physical page to be printed. Only objects drawn within the
page boundaries will appear in printouts.

¢ To set the page size and orientation, use the Format|Page Setup command.
¢ To set the page color, use the Options|Display command.



Desktop

The Drawing Window Desktop is the area around the Page. You can draw on the Desktop, but nothing
drawn off the Page will appear in printouts.

¢ To set the desktop color, use the Options|Display command.



Rulers

The Drawing Window Rulers aid in sizing and positioning objects in a drawing. The Rulers can be
displayed in different units. You can change the tick mark spacing, change the origin point, and
hide/show the rulers. A dashed line in each ruler tracks the current mouse position.

¢ To setup all Rulers display options, click on a ruler, or use the View|Ruler Setup command.
¢ To interactively set the Ruler origin, press on and drag from the Units Button.

¢ To hide/show the Rulers, use the View|Rulers command.
Associated with the rulers are a visible grid, a snap grid, and guidelines.

Related Topics:
Ruler Grid

Snap Grid
Guidelines



Ruler Grid

The visible ruler grid helps you align objects with the rulers. You can display the grid in one of several
styles (dashed lines, cross hairs, or dots), change the grid spacing and hide/show the grid.

¢ To change the ruler grid style or spacing, click on a ruler, or use the View|Ruler Setup command.
¢ To hide/show the Ruler Grid, use the View|Ruler Grid command.




Snap Grid

The snap grid helps you precisely align and size objects by forcing object edges to land on snap grid
lines. The edge that is aligned depends on the direction of motion. You can change the snap grid

spacing and disable/enable the snap grid.
¢ To change the snap grid spacing or enable/disable the grid, click on a ruler, or use the View|Ruler
Setup command.

¢ To disable/enable the snap grid, use the View|Snap To Grid command.




Guidelines

A guideline works like a single horizontal or vertical snap grid line that appears as a solid blue. Any
number of guidelines can be placed anywhere you wish in the drawing. Guidelines are useful for aligning
rows or columns of objects or nodes. You can hide/show guidelines, disable/enable guideline snap, and
adjust the snap distance.

¢ To add a horizontal/vertical guideline:
1. Move the mouse cursor over the respective horizontal/vertical ruler.
2. Press the left mouse button and drag to the position in the drawing where you want the guideline.
3. Release the left mouse button.

¢ To remove a guideline:
1. Move the mouse cursor over the guideline.
2. Press the left mouse button and drag the guideline back into the ruler it came from.
3. Release the left mouse button.

¢ To hide/show guidelines, use the View|Guidelines command.

¢ To disable/enable guideline snap, use the View|Snap To Guidelines command.

¢ To set the guideline snap distance, use the Options|Select Tool command.



Units Button

The Drawing Window Units Button displays the current ruler units, lets you quickly change the units, and
lets you interactively change the ruler origin.

¢ To set ruler units, click on the Units Button and choose the desired units from the pop-up menu.

¢ To interactively set the ruler origin:
1. Move the mouse over the Units Button.

2. Press the left mouse button and drag to the desired ruler origin location. Horizontal and vertical
blue lines will appear to help you place the origin.

3. Release the left mouse button.



Scroll Bars

The Drawing Window Scroll Bars let you move about in the drawing. They work like standard Windows
scroll bars.

Top Draw also provides an autoscroll feature. If you move an object with the Select Tool outside of the
visible part of the drawing, the drawing will automatically be scrolled to keep the object visible.



The Status Line
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The Status Line display two types of status information. When the mouse cursor is over a drawing, the
current zoom scale, mouse position, layer name and number, and selected object description are
displayed. When the mouse is over a button or a menu command, a brief description of the associated
function is displayed.



The Select Tool

The Select Tool is used to select objects to be operated on by
menu commands. It is also used to move, resize, skew, stretch,
and rotate selected objects.

The Select Tool is active when the Select Tool button is down.
To activate the Select Tool, just click on the button. To set Select
Tool Options, click on the button again.

Related Topics:

Selecting Objects
Moving Objects
Sizing Obijects
Rotating Objects
Slanting Objects
Stretching Objects



Selecting Objects

To select an object with the Select Tool, activate the Select Tool and click on the object. The part of an
object that can be clicked on depends to some extent on the type of object. In general, if some part of an
object appears solid, you can click on that part to select the object.

Here are the rules:

Filled Objects
@ To select a filled object, click anywhere in the object interior or

on the outline. An object must be closed to be filled. If an
object has a Fill Style other than None, if it has a Texture Style
other than None, or if it contains text, it is considered to be

filled.
+
preven KO Lines
i - To select a line, or any unfilled object, click on the line. For
e A skinny lines, you just have to be "near" the line as defined by

Contact Distance in the Select Tool.

Groups

To select a group, click on any object that is part of the group.
Highlighting will surround the entire group and the Status Line
will indicate that a group is selected. To treat several objects
as a group on a temporary basis, use multiple object selection.

Related Topics:

Selected Object Highlighting
Selecting Multiple Objects
Selecting Nothing

Switching to Text Tool
Cluttered Drawings



Selected Object Highlighting

Two types of highlighting are associated with the Select Tool. The first type appears the first time an
object is selected. If you click on an object a second time, the second type of highlighting appears.
Additional clicks on the object toggle the highlighting.

-
- - -

Slick 1 Primary Highlighting

. - Highlighting consists of eight squares and two double-headed
arrows. The middle top and bottom squares are used for
changing the object height. The middle left and right squares are
used for changing the object width. Corner squares are used to
change both width and height. The double-headed arrows are
used for rotating an object.

'cm :, ' Secondary Highlighting

. . Highlighting consists of eight diamonds and two double-headed
arrows. The middle top and bottom diamonds are used for
slanting an object from side to side. The middle left and right
diamonds are used for slanting an object up and down. The
corner diamonds are used for stretching an object. The double-

headed arrows are used for rotating an object.

* * N
a

Selecting Multiple Objects

When several objects are selected, they act just like a group. The selected objects can be moved, sized,
rotated, etc., together. By selecting multiple objects, you can also apply menu commands to more than
one thing at atime. Some menu commands (e.g. Arrange|Group) require multiple selected objects.

There are two ways to select more than one object with the Select Tool:

Held the Shifl Key Down

Method 1 - Shift-Click:
*‘Q 1. Hold down the Shift key.
G lish

Click 2. Click on each object.

Click

If you click again on a selected object while the Shift key is held
down, that object is deselected.

Method 2 - Box Select:

Drag
‘ 1. Move to one corner of an imaginary box surrounding the
objects to be selected.
LY

2. Press the left mouse button and drag to the diagonally
opposite corner. A dashed outline will show the current
box size.

Prass

Raloaas

3. Release the left mouse button.
An object must be entirely contained in the box to be selected.

If you hold the Shift key down during a box select, previously
selected objects will remain selected and the boxed objects will be
added to the set of selected objects.

The location chosen for Step 1 must be a clear spot on the
drawing. If you can't find a clear spot, use the right mouse button
instead of the left.

You can combine the two methods. For example, it is often convenient to use the box select method to



select a set of closely spaced objects, then shift-click to deselect a couple of objects that don't belong.

To "grab" the selected objects again or to toggle the highlighting, just click on any one of the selected
objects.



Selecting Nothing

To clear the current selection with the Select Tool, click on a clear spot in the drawing with the left mouse
button, or click anywhere with the right mouse button. The Selection Point (a bright pink "+") will appear
where you clicked.

There are several reasons for clearing the current selection:
¢ To hide the selection highlighting so you can see the drawing better.
e To see the current Default Style settings in the Style Bar.

¢ To set the Selection Point location. The Selection Point marks the spot where pasted in objects
will appear in the drawing when using the Edit|Paste command.



Switching to Text Tool

To quickly switch from the Select Tool to the Text Tool, double-click the left mouse button.
cursor is on an object containing text, the text caret will appear where you double-clicked.

If the mouse




Cluttered Drawings

What if the drawing is cluttered and you keep selecting the wrong object(s)? Try one of these:
e Lock the object(s) using the Arrange|Lock command.
¢ Hide the object(s) using the Arrange|Hide command.
¢ Divide the drawing into layers. See the Format|Layers command.



Moving Objects

e To move an object with the Select Tool, activate it then:
e T 1. Move the mouse cursor over the object.
2. Press the left mouse button. The object outline will
appear.
3. Move the mouse cursor to the new location. The object
outline will move with it to help you place the object.
4. Release the left mouse button.

Related Topics:
Object Outlines

Moving Obijects with the Snap Grid On

Moving Objects near Guidelines

Moving Obijects with the Arrow Keys



Object Outlines

The object outline usually appears as a dashed blue line the same shape as the object. For complex
objects, the outline appears as a rectangle that surrounds the object. You can change the threshold at

which the outline changes to a rectangle using the Options|Select Tool command.



Moving Objects with the Snap Grid On

If the snap grid is on, the object position will be constrained so that the leading edge falls on a grid line
during a move. The object will appear to jump from gridline to gridline. This helps to precisely position
or align objects.

¢ To turn the snap grid on/off, use the View|Snap To Grid command.
¢ To set the snap grid spacing, use the View|Ruler Setup command.



Moving Objects near Guidelines

When the edge of an object being moved with the Select Tool approaches a guideline, the object will jump
into contact with the guideline and "stick" until it is pulled far enough away. This helps to precisely

position or align objects.

¢ To set the guideline snap distance, use the Options|Select Tool command.
¢ Guidelines can be moved with the Select Tool like any other object.



Moving Objects with the Arrow Keys
To move objects in small precise increments using the arrows keys:
1. Select the object(s) to be moved using the Select Tool.
2. Press an arrow key to move the object. Each key press moves the object one increment.

To adjust the size of the motion increment, use the Options|Select Tool command and change the Nudge
Step value.



Sizing Objects
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Related Topics:

To change the size of an object:
1. Select the object with the Select Tool.

2. Move the mouse over one of the black highlighting
squares. The mouse cursor will change to a cross hair.

3. Press the left mouse button. The mouse cursor will
change to a double headed arrow and the object outline
will appear.

Move the mouse until the outline is the desired size.
Release the left mouse button.

To change the width only, use the middle left or right square.

To change the height only, use the middle top or bottom square.
To change both width and height, use a corner square.

To size from the center of an object, hold down the Shift key while
sizing.

To size proportionally, hold down the Alt key while sizing. When
sizing proportionally, a corner square must be used.

To make the width and height the same (e.g. for square
rectangles or circular ellipses), hold down the Ctrl key while
sizing.

The Shift key can also be used in combination with the Alt key or

the Ctrl key for proportional-from-center and square-from-center
sizing.

Sizing Objects with the Snap Grid On
Sizing Objects Near Guidelines



Sizing Objects with the Snap Grid On

If the snap grid is on, the object edges will be constrained to fall on grid lines while sizing. The object
edges will appear to jump from gridline to gridline. This helps to precisely size objects.



Sizing Objects Near Guidelines

When the edge of an object being sized is moved near a guideline, the object will jump into contact with
the guideline and "stick" until it is pulled far enough away. This helps to precisely size objects.



Rotating Objects
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Related Topics:

To rotate an object:

1.
2.

Controlling the Rotation Angle

Changing the Center of Rotation

Select the object with the Select Tool.

Move the mouse over one of the double-headed arrows in
the object highlighting at the top or bottom of the object.
The mouse cursor will change to a cross hair.

Press the left mouse button. The mouse cursor will
change to a circular double headed arrow and the object
outline will appear.

Move the mouse until the outline is at the desired angle.

Release the left mouse button.



Controlling the Rotation Angle

To rotate an object in steps, hold down the Ctrl key while rotating the object. To set the angular step
size, use the Options|Select Tool command.



Changing the Center of Rotation

Center Mark i
. 0 To change the center of rotation:
¥ Press 1. Select the object with the Select Tool.
Drag 2. Move the mouse over the center mark in the object

.. .“_‘ Release highlighting. The mouse cursor will change to a cross hair.
L= For new objects, the center mark will be at the center of

. the highlighting rectangle. If the center has previously
. . been moved, it could be about anywhere. An easy way to

find it is to rotate the object.

. 3. Press the left mouse button. The mouse cursor will

change to a four headed arrow around the center mark.
Move the mouse until the center is at the desired location.

Release the left mouse button.

The center of rotation is also referred to as the object "origin
point".
The new position of the center of rotation is stored with the object. This can be useful for creating

objects that rotate around a hinge point. For an example, make a copy of the Scissors shape in the
Shape Palette, ungroup it, and rotate each half of the scissors.

The center of a group of objects can also be moved. If the group is ungrouped, the group center point
goes away since the group no longer exists.



Slanting Objects
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Slanting is accomplished using the Select Tool secondary
highlighting. For side-to-side slanting, use the middle top or
bottom diamond. For up-and-down slanting, use the middle left or
right diamond.

To slant an object:

1.

4.
5.

Select the object with the Select Tool. Click on it again
to show the secondary highlighting.

Move the mouse over one of the side diamonds in the
highlighting. The mouse cursor will change to a cross
hair.

Press the left mouse button. The mouse cursor will
change to a double headed arrow and the object outline
will appear.

Move the mouse until the outline is at the desired slant.

Release the left mouse button.

To keep the height (side-to-side slant) or width (up-and-down
slant) constant while slanting the object, hold down the Ctrl key
while slanting.

To slant with respect to the object center, hold down the Shift key
while slanting.

To slant with constant width/height around the center, hold down
both the Ctrl and Shift keys while slanting.

Stretching an object deforms it as if it were made out of rubber.

To stretch an object:

1.

4.
5.

Select the object with the Select Tool. Click on it again to
show the secondary highlighting.

Move the mouse over one of the corner diamonds in the
highlighting. The mouse cursor will change to a cross
hair.

Press the left mouse button. The mouse cursor will
change to a double headed arrow and the object outline
will appear.

Move the mouse until the outline is the desired shape.

Release the left mouse button.

Note: Ellipses and all shapes based on ellipses (circle, arc, pie,
chord) are automatically converted to Bezier curves when
stretched.



The Node Tool

) The Node Tool is used to edit nodes. With it you can:
¢ Move nodes and Bezier curve node handles to reshape
lines.

e Set the Selection Point for adding a node or breaking a
line.

e Change an ellipse into a pie slice, arc, or chord.

e Select nodes to be operated on by Node Menu
commands.

The Node Tool is active when the Node Tool button is down. To
activate the Node Tool, just click on the button.

Related Topics:

Node Editing Basics

Polyline Node Editing

Bezier Curve Node Editing
Ellipse Node Editing
Line/Curve Type Conversions



Node Editing Basics

Nodes are points along a line that determine the position and shape of the line. Top Draw provides two
types of lines: polylines, and Bezier curves. The Node Menu commands work on both types. An ellipse
is a special kind of Bezier curve. Ellipse nodes don't behave like polyline or Bezier curve nodes. To
determine the type of an object, select it and read the object description in the Status Line.

Related Topics:

Selecting Objects with the Node Tool
Selecting Nodes

Moving Nodes

Node Editing Menu Commands



Selecting Objects with the Node Tool

In order to work with the nodes of an object, the object must first be selected with the Node Tool. To
select an object with the Node Tool, click on the object just as you would with the Select Tool.

To select multiple objects, hold down the shift key while clicking on each object.

Except for the Delete key, all commands that work for objects selected with the Select Tool work for
objects selected with the Node Tool. When the Node Tool is active, the Delete key will delete selected
node(s) instead of selected object(s).



Selecting Nodes

Click
To select a node with the Node Tool:

Click 1. Select the entire object by clicking on it with the Node
Tool. The nodes will be highlighted with small hollow
squares. The start node square is slightly larger.

2. Click in the node highlighting square with the Node Tool.
The node highlighting will become solid black.

Shift-Click

T . There are two ways to select multiple nodes:
Press Drag Method 1 - Shift Click:
Releass 1. Select the object or objects containing the nodes to be
selected.
2. Hold down the shift key.
3. Click on each node with the Node Tool.
Method 2 - Box Select:

1. Move to one corner of an imaginary box surrounding the
nodes to be selected.

2. Press the left mouse button and drag to the diagonally
opposite corner. A dashed outline will show the current
box size.

3. Release the left mouse button.

Moving Nodes
To move a node with the Node Tool:
* Press 1. Click on the object to be edited with the Node Tool. The
A Drag node highlighting will appear.
Release 2. Move the point of the Node Tool over a node.

Press the left mouse button.

Drag the node to the new location. The lines on either
side of the node will move along with the node so you can
see how the shape will be changed.

5. Release the left mouse button.

Node Editing Menu Commands

* To make a line more "jagged" or to add an extra corner, use the Node Tool to set the Selection Point on
the line where the additional node is needed, then use the Node|Add command.

* To make a line smoother, straighter, or shorter, select the node to be removed with the Node Tool, then
use the Node|Delete command.

* To make an open line into a closed shape or to connect two lines, select two nodes then use the Node|
Join command.

® To open a closed shape or break a line in two, select the node where the break is to occur, then use the



Node|Break command.

* To make a line segment horizontal or vertical, select the two endpoints with the Node Tool, then use the

Node|Align command.



Polyline Node Editing
All aspects of polyline node editing are covered under Node Editing Basics .
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Bezier Curve Node Editing

Basic Bezier curve node editing works as described in Node
Editing Basics . Controlling the curvature of a line segment takes
a couple more steps.

When a Bezier curve node is selected with the Node Tool, in
addition to the node box becoming solid black, the node "handles"

appear. The near handles on the two adjacent nodes also
appear. Node handles are connected to their nodes by dashed
lines.

A Bezier curve segment is defined by four points: the two nodes
that are the endpoints of the segment, and the two handles that
point towards the middle of the segment (more or less). The
curve segment always passes through the endpoints and is
attracted fowards the handles. Some examples are shown on the
left.

Moving a handle farther from its node makes the segment more
curved. Itis even possible to make loops. Moving a handle
closer to its node makes the segment less curved. If the handle
point is the same as the node point, the handle does not show up
when the node is selected. If both handle points are the same as
the corresponding node points, the segment is a straight line.

To move a node handle:
Move the Node Tool over the node handle.
Press the left mouse button.

Move to the new location. The affected lines will be
redrawn as you move the node or handle.

4. Release the left mouse button.

To control the shape of a line as it passes through a node, set the
node attributes using the Node|Attributes command.

To make handles appear, set the Curve Before and Curve After
checkboxes on.

To make a smooth line through a node, turn the Same Angle
checkbox on. To make a corner at a node, turn the Same Angle
checkbox off and move one or both handles.

To constrain both handles to be the same distance from the node,
turn the Same Length option on. To allow different length
handles, turn the Same Length option off.

Ellipses are created with the Shapes Tool. When a new ellipse is
selected with the Node Tool, it appears to have a single node. It
actually has two nodes that happen to be in the same place. The



nodes determine the start and end angles of an elliptical pie slice,
arc segment, or chord.

To create a pie slice:

1. Move the Node Tool over the ellipse node.

w 2. Press the left mouse button.

3. Move the mouse cursor around the ellipse outline. As
long as the mouse cursor is near the outline, both ellipse
nodes will move together. When the mouse cursor
moves off the outline, one node will stop, and the other

( will keep moving.

4. When you reach the desired location for the first node,
move inside the ellipse outline.

5. Continue moving the mouse inside the outline until you
reach the position for the second node. Refer to the
figure on the left.

6. Release the left mouse button.

If the nodes end up in the wrong place, just move them again with
the Node Tool. The nodes will continue to follow the original
ellipse outline.

To create an elliptical arc segment, use the same process as for
creating a pie slice, but instead of moving the mouse inside of the
ellipse, move it outside.

A chord is like a pie slice, except the two nodes are connected
directly to each other instead of to the center of the ellipse. To
create a chord, use the same process as for creating a pie slice,
but hold down the Ctrl key.

Ellipses, pie slices, arcs, and chords can be resized, rotated, and
slanted. If one of these is stretched, it is automatically converted
to a Bezier curve of the same shape.

Line/Curve Type Conversions
Type conversions allow you to work with a shape in the form that is most convenient:

e To convert an object to a polyline, select the object and perform the Format|Convert To Polyline
command.

e To convert an object to a Bezier curve, select the object and perform the Format|Convert To
Curves command.
The original type of a shape depends on how it was created:
¢ Shapes added using the Shapes Tool always have the same type as the original.

¢ Shapes created using the Draw Tool can be either polylines or Bezier curves. Use the Options|
Draw Tool command or click twice on the Draw Tool button to display the Draw Tool Options



dialog, then set the Line Conversion options.

* An ellipse can only be created with the Shapes Tool. The second shape in the Shapes Palette
is always an ellipse.

The following type conversions are supported:

e Polyline to Bezier Curve

e Bezier Curve to Polyline

¢ Ellipse to Bezier Curve

e Ellipse to Polyline

Note: Conversion from a Polyline to a Bezier curve form can result in a slight change in shape since
curve fitting is approximate.



The Text Tool
_T |

Related Topics:

Creating Paragraph Text
Text Editing
Text Styles

The Text Tool is used to add text to a drawing, to edit existing
text, and to select text for menu commands and keyboard
commands. The Text Tool is active when the Text Tool button is
down. To activate the Text Tool, just click on the button.

Editing text in Top Draw is similar to working in a powerful, yet
easy to use, word processor. All text editing is by direct
manipulation in the drawing. A complete set of character and
paragraph styles is supported and the styles can be mixed freely.



Creating Paragraph Text
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Related Topics:

Paragraph text is always attached to a drawing object. The
"container" object can have any line type and can be any shape.

It can be any style, including invisible (no fill, no outline). The text
will be arranged to match the shape of the container (within
reason).

If the object is not big enough to hold all of the text, the text that
"falls off the bottom" becomes invisible. If you put large
characters in a small container, it is possible that none of the text
will be visible until you make the container bigger.

The "text caret" marks the current text insertion point. The text
caret appears as blinking vertical bar when in "insert" mode, and
as a blinking box when in "overwrite" mode. The initial position of
the text caret in a new container depends on the current
Paragraph Style. The initial size of the text caret depends on the
current Character Style.

Creating New Paragraph Text
Adding Paragraph Text to an Existing Object



Creating New Paragraph Text
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The Text Tool can be used to create an invisible rectangle to hold
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new text as follows:

Move the mouse cursor to one corner of the rectangle.
Press the left mouse button.

Drag the mouse to the other corner of the rectangle. A
dashed blue outline will be drawn to show the current
rectangle size.

Release the left mouse button. The text caret will appear
in the rectangle just created.

Start typing to add text. See the Text Editing section for
details on editing commands.

The invisible rectangle created by the Text Tool is an ordinary
rectangle that can be resized, reshaped, and changed to any style.



Adding Paragraph Text to an Existing Object
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Text Editing

To add text to an existing object:

1. Click on the object with the Text Tool. The text caret will
appear. If the object already contains text, the text caret
will appear in the text where you clicked. Otherwise, the
text caret will appear in the usual starting location for the
current Paragraph Style.

2. Start typing to add text. See the Text Editing section for
details on editing commands.

Shortcut. To add text to the currently selected object, just start
typing. If the object already contains text, the existing text is
replaced. The object can be selected with the Select Tool or

Node Tool, or newly created with the Shapes Toal.

Adding Text to Open and Complex Shapes

Paragraph text can be added to open shapes and complex
shapes, but some experimentation may be required to determine
which lines are being used as borders for positioning the text.

Adding Text to Groups

Paragraph text can be attached to a group, but be careful! If you
ever have to ungroup the group, the text will be deleted along with
the group. Itis generally better to create a standalone text object
than make it a member of the group.

Most Top Draw text editing commands will be familiar to experienced Windows users.

Related Topics:

Typing Text
Moving the Text Caret
Selecting Text

Copying, Cutting, and Pasting Text

Deleting Text



Typing Text
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Selecting Text

Once an object has been selected with the Text Tool, new text is
added by typing the desired characters.

In insert mode, the text caret is a vertical line and a new character
is inserted at the text caret.

In overwrite mode the text caret is a box and a new character
replaces the character currently highlighted by the text caret. The
text caret moves to the right as new text is entered.

To toggle between insert and overwrite mode, press the Insert
key.

To position the text caret using the Text Tool:
1. Move the mouse cursor to the desired location in the text.

2. Click the left mouse button. The text caret will jump to the
new location.

To position the text caret using the keyboard:

Arrow Key Function
Left Left one character.
Right Right one character.
Up Up one line.
Down Down one line.
Ctri+Left Left one word.
CtrlI+Right  Rignt one word.
Edit Key Function
Home Start of line.
End End of line.
Page Up Start of paragraph.
Page Down  Enpg of paragraph.

Many commands, such as Copy, Cut, Paste, and text style
changes, require that you select the block of text to be operated
on by the command. The following sequences assume an object
has already been selected with the Text Tool.



Position tha mousa .
cursar and PTTEETR To select text with the mouse:

1. Move the mouse cursor to the start of the block of text to
be selected.

LEES The selected
text is highlighted.

Press the left mouse button.

Drag the mouse to the end of the block of text. The
selected text will be highlighted as you move the mouse.

4. Release the left mouse button.
Hold down the Shift key

while SRR the text To select text using any text caret movement technique:

carel o select the text ven

betwaen the old and 1. Position the text caret at the start of the block of text to be
new taxt caret positions selected.

2. Hold down the Shift key.

Move the text caret to the end of the block of text. The
selected text will be highlighted as you move the text
caret.

4. Release the Shift key.
To select a word:
1. Move the mouse cursor to a position inside the word.

2. Double-click the left mouse button. The word will be
highlighted.

Copying, Cutting, and Pasting Text
To copy or cut text to the Clipboard:
1. Select the text to be copied, cut, or deleted.
2. Perform the Edit|Copy or Edit|Cut command.
To paste text from the Clipboard:

1. Position the text caret where the text is to be inserted.
2. Perform the Edit|Paste command.




Deleting Text

The currently selected block of text is deleted when you: type new text, paste new text, press the Del or
BkSp key, or perform the Edit|Delete command.

The following keys can be used to delete characters:

Key Function
Backspace Delete character to left of text caret.
Delete Delete character to right of text caret.
Text Styles

Text styles are divided into Character Styles, which apply to individual characters, and Paragraph Styles,
which apply to paragraphs and text containers.

Related Topics:

Character Styles
Paragraph Styles



Character Styles

The styles that apply to individual characters are:

FONTS
Font (typeface)
Slgger Sman: Size (overall size)
W id e Normal Mmw i i X
Width (horizontal size)
CondensedE x panded . .
Spacing (distance between characters)
Bodd Halic Urderire Simkeont i i
Style (special character attributes)

Supergeript g,p5eript . . .
Super/subscript  (vertical position)

RAl oW
Color (solid fill color)

To set all styles except color, select the text to be modified and use the Format|Character Style command
or a Style Bar button.

To set text color, select the text to be modified and change Fill Color 1 on the Style Bar.



Paragraph Styles

The styles that apply to individual paragraphs are:
Horizontal Alignment (left, centered, right, justified)
Indentation (left, right, first line)

Line Spacing (distance between lines)

The styles that apply to all of the text in a container are:
Vertical Alignment (top, centered, bottom)
Spacing (top, bottom, between paragraphs)

A paragraph is selected for style changes if any character in the paragraph is selected, or if the text caret
is currently in the paragraph. If the container object is selected, styles changes apply to all of the text in
the container.

To set paragraph styles, select the text to be modified and use the Format|Paragraph Style command or a
Style Bar button.

Hint: If a text container object has a pointy top or bottom, increase the top or bottom spacing so that the
text begins/ends where the container is wider. Otherwise, the line wrapping algorithm will break words to
get text to fit in a line that is too narrow.



The Draw Tool
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Related Topics:
Draw Tool Options

The Draw Tool is used to draw new shape outlines. It can be
used to draw straight lines, freehand lines, and combinations of
both. The outline can be open or closed. The Draw Tool can be
used to create both polylines and Bezier curves.

The Draw Tool is active when the Draw Tool button is down. To
activate the Draw Tool, just click on the button. To set Draw Tool
Options, click on the button again.

Drawing Straight and Freehand Lines
Line, Fill, and Texture Styles



Draw Tool Options

The Draw Tool Options let you control the way new lines are created using the Draw Tool. The
following options can be set using the Options|Draw Tool command:

Freehand Point Spacing
Controls the minimum distance between adjacent points when
drawing freehand lines.

Join/Close Distance

Controls the distance for points to be considered "touching" when
automatically attaching a new line to an existing line, or closing a
line.

w 4s° Control Angle Spacing
Controls the rotational angle between steps when pivoting a new

straight line segment with the Ctrl key down.

Multipla . .
Multiple/Single Segment

In Multiple Segment mode (the default), the Draw Tool keeps

Single adding line segments to a new line until you double click the left
mouse button. In Single Segment mode, the Draw Tool finishes
a new line as soon as you release the left mouse button after
freehand drawing or after clicking on the second point of a straight
line. Holding down the Shift key temporarily toggles from the
current mode to the opposite mode.

Grid Freehand Input
When this option is on, all freehand input points are forced to fall
on snap grid lines. By default, this option is off.

= Simplify Polyline
When this option is on (the default), points that fall in the middle of
a nearly straight line are deleted before the new line is added to
the drawing.

| 4

Convert To Curves

When this option is on (the default), new lines are converted and
added to the drawing as Bezier curves. When off, they are added
as polylines.

Drawing Straight and Freehand Lines

To draw a straight line with the Draw Tool:

Click

Click 1. Move the mouse cursor to the start point.
2. Click the left mouse button.
3. Move to the end point. A "rubber line" will be drawn from

the start point so you can see where the line will go.
4. Click the left mouse button again (see Note).
Braw To draw a freehand line with the Draw Tool:
Prass Release

1. Move the mouse cursor to the start point.
2. Press the left mouse button.

3. Draw the desired contour while holding the left mouse



button down.
4. Release the left mouse button (see Note).

Note: In Single Segment mode, a new line will be added to the drawing at the end of Step 4. In Multiple
Segment mode, a new straight line segment will be started. To finish the line in Multiple Segment mode
you can 1) double-click, 2) hold the Shift key down during Step 4 , or 3) click the right mouse button to
drop the last line segment and complete the line.

Related Topics:

Combining Straight and Freehand Lines
Drawing Open and Closed Outlines
Connecting To Existing Lines
Correcting Mistakes



Combining Straight and Freehand Lines

First, set the Draw Tool mode to Multiple Segment using the Options|Draw Tool command, or hold down
the Shift key if in Single Segment mode.

Diraw

To follow a straight line with a freehand line, press and hold down
Click Tre%%  Relpase the left mouse button at the second straight line point (instead of
clicking), then draw with the mouse while continuing to hold the

left mouse button down.
o
- To follow a freehand line with a straight line, release the left mouse

Click button. A new straight line segment will automatically be started.

Prass Release

Drawing Open and Closed Outlines

To draw an open outline, make sure the first and last points drawn
are not close together.

To draw a closed outline, make sure the first and last points are
close together.

Opan Closed
Connecting To Existing Lines

To connect a new line to a line already in the drawing, start or end the new line at an endpoint of the
existing line. You can also connect both the start and end of a new line to existing lines. The existing
line must be open, not closed.

The style of the existing line is converted to the current Default Style when it is connected to the new line.



Correcting Mistakes
To delete the last point(s) in a line while drawing with the Draw Tool in Multiple Segment mode:
1. Release left mouse button.

2. Press the Backspace key. Press again to delete another point.



Line, Fill, and Texture Styles

The current default Line Style is used to display freehand lines and completed straight lines as you draw
with the Draw Tool. The current default Fill and Texture Styles are used to draw the interior of a
completed closed shape.

The current Default Style is shown in the Style Bar sample boxes when nothing is selected.

To change the Default Style, make sure nothing is selected . To change the style of an object, make sure
the object is selected using the Select Tool. Then, use one or more of the following commands or the
corresponding Style Bar buttons to modify styles:

e Format|Line Style
e Format|Fill Style
e  Format|Texture Style



The Shapes Tool

L]

Related Topics:

Drawing a Shape
The Shape Palette

The Shapes Tool is used to add predefined shapes to a drawing,
and to access the Shape Palette.

The current shape is displayed on the Shapes Tool button in the
style that will be used when it is added to the drawing, so it will not
always have a white square on it as shown on the left..

The Shapes Tool is active when the Shapes Tool button is down.
To activate the Shapes Tool, just click on the button. To display
the Shape Palette, click on the button again.




Drawing a Shape

Press

To draw a shape with the Shapes Tool:

Drag
1. Move to the starting corner on an imaginary rectangle that
. will surround the new shape.
Releass
P 2. Press the left mouse button.

Drag to the diagonally opposite corner. The shape
outline will be drawn to help you position and size the
shape.

4. Release the left mouse button.

The relative position of the starting and ending corners determines
the orientation of the shape. Normal is top-left to bottom-right.
Drawing bottom-to-top flips the shape vertically, drawing right-to-
left flips it horizontally.

Alternate Sizing Methods

The Shapes Tool supports the same sizing method alternatives
as the Select Tool:

e To size from the center, hold down the Shift key.

¢ To make the height equal the width, hold down the Ctrl
key.

¢ To maintain the proportions of the original shape, hold
down the Alt key.

e The Shift key can be used in combination with the Ctrl
key for square-from-center sizing, and in combination with
the Alt key for proportional-from-center sizing.

The Shape Palette

The Shape Palette is used to access and modify sets of shapes.lIt is displayed by clicking twice on the
Shapes Tool.

The shapes are stored in files with the "tds" suffix. The default shape set is stored in the file
"assorted. tds" in the Top Draw directory.

Related Topics:

Choosing a Shape

Controlling the Style of a New Shape
Changing Shape Sets

Creating a New Shape Set
Customizing a Shape Set



Choosing a Shape
To choose a shape from the Shape Palette:
1. Scroll until you see the desired shape.
2. Click on the shape to selectit. A black box will highlight the selected shape.

3. Click on the shape again, or click OK to close the palette and change the shape on the Shapes
Tool button.



Controlling the Style of a New Shape

A new shape can be created using either the current Default Style, or the same style as the original
shape.
To use the current Default Style, choose Use Current Style in the Edit Menu of the Shape Palette.

To use the original style, choose Use Master Style in the Edit Menu of the Shape Palette.



Changing Shape Sets

To change to a different shape set, open a different shape file by choosing Open in the File Menu of the
Shape Palette. Choose a file name using the File Open dialog and click OK.



Creating a New Shape Set

To create a new shape palette, choose New in the File Menu of the Shape Palette. The first four
shapes are predefined and cannot be modified. Additional shapes can be added is described in

Customizing a Shape Set.



Customizing a Shape Set

A shape set is customized by adding new shapes or changing existing shapes. Shapes are created by
drawing in a regular drawing file. Shapes are transferred to the Shape Palette via the Windows
clipboard. The entire shape set is then saved to a file.

Here are some guidelines for creating shapes that work well in the Shape Palette:

¢ Keep shapes relatively simple. Stick to symbols or objects that you use frequently in you daily
work.

¢ Avoid styles that don't scale with the object. Use 0 or 1 point lines without arrowheads or
dashing. Avoid textures.

¢ Avoid text since it won't scale with the object.

¢ When creating the original drawing, make it at least 2 inches by 2 inches. Bigger is fine.
To copy a shape to the clipboard:

1. Select all of the shape with the Select Tool.

2. Perform the Edit|Copy command.
To put the shape in the Shape Palette:

1. Scroll to and click on the cell to receive the shape. The cell will be highlighted by a black
rectangle.

2. Choose Replace in the Edit Menu of the Shape Palette. The shape will appear in the selected
cell.

3. Give the object a unique name by editing the string in the Name edit box in the Shape Palette.

To save a Shape Set:
1. If you haven't named the Shape Set, edit the string in the Group edit box in the Shape Palette.
2. Choose Save in the File Menu of the Shape Palette.
3. Choose directory and a file name using the File Save As dialog and click OK.



The Notes Tool

:l The Notes Tool is used to add notes to a drawing. Notes can be
printed as part of the drawing, or hidden. Note text can be printed
on a title page when the drawing is printed.

Prazs

To add a note to the current drawing:

Drag 1. Click on the Notes Tool if it is not already active.

2. Move the mouse cursor to one of the note corners.

Raleass

Toxt Carst 3. Press the left mouse button and drag to the diagonally
3 opposite note corner. A dashed blue line will be drawn to
indicate the rectangle size.

4. Release the left mouse button. A new rectangular yellow
note will appear with the text caret blinking inside it. The
starting position of the text caret depends on the current
Paragraph Style.

5. Starttyping. Note text is edited using the same
commands as regular text. The same default text style is
used for both regular text and for notes.

To edit text in an existing note:
1. Click on the Notes Tool if it is not already active.
2. Click on the note. The blinking text caret will appear.

3. Edit the note text using the same commands as regular
text.

When a note is selected, the selected object description in the Status Line includes "[Note]" before the
layer number.

The note text container, the yellow rectangle, can be modified like any other object (size, shape, style, etc.
can be changed). Be careful though, or you may loose track of which objects are notes.

To hide/show all notes, use the View|Notes command.

To print note text on a title page, use the File|Print command and set the Title Page and Notes
checkboxes on.



The Zoom Buttons

The Zoom Buttons allow you to change the magnification (scale) at which a drawing is displayed, and to
select the section of the drawing to magnify.

Each of the Zoom Buttons provides two related functions, one for the left mouse button, and one for the
right:

+ Zoom In
Left Zoom to selected region.
Right Zoom in by 2X (make image two times bigger).
J Zoom to Fit
Left Zoom to fit Drawing Window.
Right Zoom to 100%.
E Zoom Out
Left Zoom to previous scale.
Right Zoom out by 2X (make image two times smaller).
The left/right mouse button functions can be exchanged using the Options|Zoom Buttons command.
N Except for zooming in to a selected region, all you have to do is
G click on the appropriate Zoom Button. To zoom in to a selected
region:
nm:n ~ 1. Click on the Zoom In Tool. The mouse cursor will

change to look like the Zoom In Tool.

2. Move the cursor to the top left corner of the area you want
to zoom in on.

Press the left mouse button.

Drag to the bottom right corner of the area you want to
zoom in on. A dashed rectangle will be drawn around the
area as you drag.

5. Release the left mouse button.

Unless the rectangle you select has exactly the same proportions
as the drawing window, the displayed area will be slightly larger
than the selected region after zooming in.

The Layer Buttons

The Layer Buttons let you move up and down through the layers of the current drawing.

j Layer Up

Click on this button to move to the next layer up in the drawing. If
there isn't one, it beeps.

j Layer Down
Click on this button to move to the next layer down in the drawing.

If there isn't one, it beeps.



The number and name of the current layer, and the layer that the currently selected object belongs to, are
displayed in the Status Line.

To set up drawing layers, use the Format|Layers command.






New
Creating a New Drawing

The File|New command creates a new, empty drawing. The drawing is given a default name such as
"Drawing-X", where X is a number.

The new drawing has the same configuration (page size and orientation, ruler setup, ruler grid style, etc.)
as the last active drawing.

Any number of drawings may be open at the same time, limited only by available memory.



Open
Opening a Drawing File

The File]|Open command opens or imports an existing drawing file.  Opening a file creates a new
drawing. Importing a file reads it into the current drawing.

To open or import a file:
1. Select a Drive

The current drive is shown below the Drives heading. To switch to a different drive, select one from the
drop-down list.

2. Select a Directory

The current directory is shown below the Directories heading as a DOS pathname, and illustrated in tree
form. To switch to a different directory, double-click on folders in the directory tree.

3. Select a File Type

The current file type is shown below the List Files of Type heading. To select a different file type,
choose one from the drop-down list.

Top Draw can read drawing files of the following types:
* . tdr (Top Draw format)

.wmf (Windows Metafile)

.bmp (Windows Bitmap)

.pcx (PC Paintbrush Bitmap)

* F %

4. Select a File Name

Select an existing file to open by clicking on one of the file names in the File Name list box. You can also
type a name in the File Name edit box. If the file does not exist, a new empty drawing is created with the
given name.

5. Importing a File

To import the selected file, click on the Import check box. Importing a file places the image contained in
the file into the current drawing, in the current layer, at the Selection Point. Files of any supported type,
including * . tdr, can be imported.

6. Click OK



Save
Saving a Drawing

The File|]Save command saves the current drawing to a file using the current file name.

If the current drawing has never been saved, the File|Save As command is automatically used instead.



Save As
Saving a Drawing with a New Name or New Format

The File|Save As command saves the current drawing to a file. This command can be used to save a
new drawing to a file, to save a previously saved drawing under a different file name, or to save a drawing
in a different format.

To save a drawing to a file:
1. Select a Drive

The current drive is shown below the Drives heading. To switch to a different drive, select one from the
drop-down list.

2. Select a Directory

The current directory is shown below the Directories heading as a DOS pathname, and illustrated in tree
form. To switch to a different directory, double-clicking on folders in the directory tree.

3. Select a File Type

The current file type is shown below the List Files of Type heading. To select a different file type,
choose one from the drop-down list.

Top Draw can write drawing files of the following types:
* . tdr (Top Draw format)
* _wmf (Windows Metafile).

4. Select a File Name

Type a file name in the File Name edit box. A file type extension will be automatically added if you don't
provide one. The currently selected file type will be used.

To select an existing file name, click on one in the File Name list box.
5. Click OK



Annotate
Annotating a Drawing

The File]Annotate command lets you add or edit textual information associated with a drawing.
To annotate a drawing:

1. Check the File Name

The name of the current file is shown in the File text box.

2. Enter the Drawing Title

Type/edit the drawing title in the Title edit box.

3. Enter the Drawing Author

Typeledit the author's name in the Author edit box.

4. Enter Comments

Type/edit any additional comments in the Comments edit box.
5. Click OK

Related Commands

Annotation information can be printed on a title page when you print your drawing (see the File|Print
command).

You can also add notes in your drawing and print note text on the title page (see the Notes Tool).



Print
Printing a Drawing

The File|Print command sends the current drawing to the printer.
To print a file:
1. Check the File and Printer Name

The current drawing file name is shown in the File text box. The currently active printer name is shown
in the Printer text box.

2. Select the Number of Copies
Edit the number of copies or use the arrow buttons to increase or decrease the number of copies.
3. Set the Print Scale

To rescale a drawing as it is printed, edit the print scale or use the arrow buttons to increase or decrease
it. Set the scale to 100% to print the drawing at the same size as it is displayed while editing. Changing
the print scale does not modify the original drawing.

4. Set Title Page Options

To print a title page, click on the Title Page check box. To print Annotations and/or Notes, click on the
corresponding check box(es).

5. Set the Print Selected Objects Only Option
To print just the current selection, click on the Print Selected Objects Only check box.
6. Click OK

Printer Setup

Click on the Setup button to modify configuration options for the current printer. This functionality is part
of Windows. For additional information, use the Help buttons in the printer setup dialog boxes.



Printer Setup
Selecting and Configuring a Printer

The File|PrinterSetup command can be used to change to a different printer and to set configuration
options for the current printer.

To setup a printer:
1. Select a Printer

Click on a printer in the list displayed to select it as the current printer. The list you see depends on
which printers are installed on your computer.

2. Set Printer Options

Click on the Setup button to set configuration options for the selected printer. This functionality is part of
Windows. For additional information, use the Help buttons in the printer setup dialog boxes.

3. Click OK



Close
Closing a Drawing

The File|Close command closes the current drawing. If the drawing has been modified since it was last
saved, you will be prompted to save the file first.

See also: Window|Close All



Exit

Exiting Top Draw

The File|Exit command closes all open drawings, prompting you to save any modified drawings, then
exits the Top Draw application.

Note: The Close command on the Control menu does the same thing.



Edit Menu

Undo
Redo

Copy Style
Set Style

Duplicate
Select All



Undo

The EditjJUndo <op> command undoes the last editing operation. The menu is changed so that <op>
indicates which operation is to be undone.

Five levels of undo are provided. You can undo the last five editing operations by performing undo five
times in a row.

All menu commands and tool operations can be undone except:
File operations (open, save, close, etc.)
Window operations (tile, cascade, change active window, etc.)
View operations (show/hide subwindow, snap on/off, etc.)
Option setting (Display, Select Tool, Zoom Buttons, etc.)



Redo

The Edit|Redo command redoes the last undo operation.

Five levels of redo are provided. You can redo the last five undo operations by performing redo five
times in a row.



Cut

The Edit|Cut command copies the current selection to the Windows clipboard and removes it from the
drawing.

See the Edit|Copy command for information on clipboard formats used by Top Draw.



Copy

The Edit|Copy command copies the current selection to the clipboard.

If the current selection is one or more drawing objects, the objects are copied to the Windows clipboard in
Metafile format. Most Windows programs that support graphics can paste-in data in Metafile format.

If the current selection is a block of text, it is copied to the Windows clipboard in "plain” text format. Most
Windows programs that handle text can paste-in plain text.

Top Draw uses an internal clipboard to speed up cut-and-paste operations between Top Draw drawings.
Shape and text data are kept on the internal clipboard in internal format.

If you exit and restart Top Draw, the contents of the internal clipboard are destroyed so the data cannot
be pasted in internal format.



Paste

The Edit|Paste command copies the contents of the clipboard into the current drawing at the Selection
Point or the text caret. The result of this command depends on the clipboard contents:

If the clipboard contains Top Draw shape data, it is placed in the drawing at the Selection Point.

If the clipboard contains Metafile data, it is converted to Top Draw internal format and placed in the
current drawing at the Selection Point.

If the clipboard contains Bitmap or DIBitmap data, it is placed in the current drawing at the Selection Point
in bitmap format.

If the clipboard contains Top Draw text data and the text caret is active, the text is added at the caret
position, preserving original formatting.

If the clipboard contains plain text and the text caret is active, the text is added at the caret position in the
same format as the preceding text.



Delete
The Edit|Delete command removes the current selection from the drawing.
If the current selection is one or more shapes, the shapes are deleted.

If the current selection is a block of text, the block of text is deleted.



Copy Style
The Edit|Copy Style command copies the style of the current selection to the Default Style.
If the current selection is a shape, the Line, Fill, and Texture Styles are copied to the Default Style.

If the text caret is active, the Character and Paragraph Styles at the text caret position are copied to the
Default Style.



Set Style
The Edit|Set Style command sets the style of the current selection from the Default Style.
If the current selection is a shape, the Line, Fill, and Texture Styles are set from the Default Style.

If a block of text is select, the Character and Paragraph Styles of the block are set from the Default Style.



Duplicate
The Edit|Duplicate command adds a duplicate of the currently selected objects(s) to the drawing. The
duplicate is offset slightly from the original.

To change the horizontal and vertical duplication offsets use the Options|Select Tool command.



Select All

The Edit|Select All command selects all of the objects in the current drawing. This is useful for resizing,
moving, or copying an entire drawing.



View Menu

Redraw Now
Wireframe

Style Bar

Status Line
Rulers

Ruler Grid
Guidelines

Notes

Paragraph Marks
Snap to Grid
Snap to Guidelines
Ruler Setup




Redraw Now

The View|Redraw Now command redraws the currently selected object(s). If nothing is selected, the
entire drawing is redrawn. This command is useful for cleaning up an object after node editing, or
cleaning up stray marks that occasionally appear on a drawing.



Wireframe
Wireframe View On/Off

The View|Wireframe command turns the wireframe view on/off.
. In wireframe view, only the outlines of objects are drawn. This is
useful when performing node editing in a complex area of a

N I Wiref . . .
orma relrame drawing, or for speeding up redrawing on slower computers.

Style Bar

Show/Hide the Style Bar
The View|Style Bar command shows/hides the Style Bar. Hide
the Style Bar when you need a little extra space on the screen for
your drawing, and you don't need the command shortcuts and
style status information provided on the Style Bar.

Status Line
Show/Hide the Status Line

The View|Status Line command shows/hides the Status Line.
Hide the Status Line when you need a little extra space on the
screen for your drawing, and you don't need the status information
provided on the Status Line.

Rulers
Show/Hide Rulers

The View|Rulers command shows/hides the rulers for the current

"‘ drawing. Hide the rulers when you need a little extra space on
the screen for your drawing, and you don't need the rulers for
keeping track of object locations in the drawing.

Ruler Grid
Show/Hide Ruler Grid
The View|Ruler Grid command shows/hides the ruler grid for the current drawing. Hide the grid when

you want to work with a "clean piece of paper". The snhap grid may be enabled or disabled whether or
not the ruler grid is visible.



Guidelines
Show/Hide Guidelines

The View|Guidelines command shows/hides any guidelines in the current drawing. Guideline snap is
disabled when the guidelines are hidden.



Notes
Show/Hide Notes

The View|Notes command shows/hides any notes in the current drawing. Hide notes when you need to
print a drawing without the notes showing up in the printed output or when you need to get them out of the

way while working on a drawing.




Paragraph Marks

Show/Hide Paragraph Marks

The View|Paragraph Marks command shows/hides paragraph marks in text. Show paragraph marks
when you need to figure out where the paragraph marks actually are, i.e., to distinguish between
automatic word wrap and a paragraph break.



Snap to Grid
Snap Grid On/Off

The View|Snap To Grid command turns the snap grid on/off. With snap on, the mouse is forced to stay
on the grid and jumps from gridline to gridline. With snap off, the mouse moves smoothly.

Turn the snap grid on so that you can easily align objects or make them the same size with little effort.
Turn the snap grid off so that you can move and size objects smoothly and make small adjustments.



Snap to Guidelines
Guideline Snap On/Off

The View|Snap To Guidelines command turns guideline snap on/off. Turn guideline snap on so that
you can use guidelines for aligning drawing objects. Turn guideline snap off to move objects smoothly

and make small adjustments near a guideline.



Ruler Setup
Set Ruler and Ruler Grid Appearance

The View|Ruler Setup command can be used to set the ruler units, the ruler origin, ruler mark spacing,
visible grid line spacing and style, snap grid spacing, and snap grid on/off.

Configure the rulers or ruler grid by modifying the option(s) of interest:

Units
Select the desired units from the drop down list. All Ruler Setup option values will be redisplayed in the
new units.

Ruler Origin

Enter the desired ruler origin positions in current units relative to the center of the page. Or, use the
arrow buttons to increment/decrement the origin position values. The red dots in the gray rectangle to
the left of the Cancel button show the current origin position relative to the page. The page is
represented as a white rectangle.

Ruler Mark Spacing
Select the desired ruler mark spacing from the list provided. If "Auto” is selected, the mark spacing will
be adjusted according to the current drawing zoom scale.

Grid Line Spacing
Select the desired visible grid line spacing from the list provided. If "Auto" is selected, the grid line
spacing will be adjusted according to the current drawing zoom scale.

Snap Grid Spacing
Select the desired snap grid spacing from the list provided. If "Auto” is selected, the snap grid spacing
will be adjusted according to the current drawing zoom scale.

Snap Grid On/Off
Click on the Snap Grid checkbox to turn on the snap grid (checkmark visible). Click again to turn off the
snap grid (checkmark not visible).

See also: View|Snap To Grid

Grid Style

Select the desired visible grid line style from the list provided (Dashed-Lines, Cross-Hairs, or Dots). Click
on the Extend Grid to Rulers checkbox to draw the grid all the way to the rulers even at low zoom
scales, or leave it off if you want the grid only to appear on the white page.




Arrange Menu

Forward
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The Arrange|Forward command moves the selected object(s)
one position forward in the drawing.

If an object is at the front of the layer it belongs to, it is moved to
the back of the next higher layer, if there is one. If it is already at
the front of the drawing, it is not moved.

The Arrange|To Front command moves the selected object(s) to
the front of the drawing, i.e., to the front of the front layer.

The Arrange|Backward command moves the selected object(s)
one position backward in the drawing.

If an object is at the back of the layer it belongs to, it is moved to
the front of the next lower layer, if there is one. If it is already at
the back of the drawing, it is not moved.

The Arrange|To Back command moves the selected object(s) to
the back of the drawing, i.e., to the back of the back layer.

The Arrange|Group command forms the selected objects into a
group so they act as a single object for moving, sizing, and other
operations.

Groups are useful for keeping the parts of a completed figure
together. For example, all predefined shapes on the Shapes
Palette that have more than one part are defined as groups.

Groups can be grouped like any other object, so it is possible to
have multiple levels of grouping.

Grouping does not change the appearance of the grouped objects, but it may change the front/back

position of the grouped objects relative to objects outside of the group since the group itself must occupy

a single front/back position in the drawing.
The Arrange|Ungroup command breaks apart groups.



Merge
Marging can creale

see-through holes...
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Ungroup

The Arrange|Merge command forms the selected objects into a
merged group. A merged group is just a like a regular group
except that a merged group has a single style and, when filling a
merged group, the outlines of the merged objects are treated as a
single outline.

The style of the top (front) selected object is used as the initial
style of the merged group. The style can be changed at any time
using the usual style commands.

Merging can be used to create objects with see-through holes,
and to make a fill pattern extend across multiple objects, as shown
in the examples.

The Arrange|Ungroup command breaks apart merged groups.

The Arrange|Ungroup command breaks selected Grouped or Merged objects back into individual
objects. If there are multiple levels of grouping or merging, Ungroup only breaks the top level.

Objects must be ungrouped to change the style, size, or relative position of an individual object. Node
editing can be performed without ungrouping.



Transform

The Arrange|Transform command can be used to precisely move, resize, reflect, slant, rotate and

duplicate drawing objects.

To transform the selected object(s) follow the instructions for the transform(s) of interest:
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Pivot Point

The pivot point is a reference point on the selected object(s) used
for all transformations. The Pivot Point is defined relative to an
imaginary rectangular box just big enough to contain the object(s).
The default pivot point is the center of the box. You can also
select a corner or the center of one of the four edges.

Relative Move

To move an object relative to its current location, enter the desired
offsets in the horizontal and vertical directions. Positive numbers
will move the object right and up, negative will move it left and
down.

Absolute Move

To move an object to an absolute screen location, as indicated by
the rulers, enter the desired horizontal and vertical position values
and click on the Absolute Move checkbox. The pivot point
determines what point on the object will be placed at the given
screen location (the default is the center of the object).

This is the "before" picture for the following Transform examples.

Resize

To resize an object, enter the desired horizontal and vertical
scales. An object is resized around the pivot point, i.e., the pivot
point remains stationary while the rest of the object shrinks or
grows.

Mirror
To mirror horizontally, set the horizontal Resize scale to -100%.

To mirror vertically, set the vertical Resize scale to -100%.

Slant

To slant an object horizontally or vertically, enter desired angles.
Positive numbers will slant the object clockwise, negative
counterclockwise. An object is slanted around the pivot point, i.e.,
the pivot point remains stationary while the rest of the object is
slanted.

Rotate

To rotate an object, enter the desired angle of rotation. Positive
numbers will rotate the object clockwise, negative
counterclockwise. An object is rotated around the pivot point, i.e.,
the pivot point remains stationary while the rest of the object is
rotated.



b Duplicate
'fn'.l You can duplicate a transform any number of times. The
o LN transform is repeatedly applied to the last result, so you can create
g DSt 17 times interesting spirals, flowers, nested shapes, and more.
avaid-0.1], Raaize|90% 99%],
Phvet Poket s tonte: of gk i To duplicate a transform, click on the Duplicate checkbox and

enter the desired number of repetitions.

Hint: You can create quite a mess if you use large repeat values
along with Resize scales > 100% and/or large move offsets. Start
small until you get a feel for what is happening.

Defaults
Click the Defaults button to reset the Transform parameters to
their original default values (which leave the selected object as is).

Align

The Arrange|Align command can be used to precisely align drawing objects to each other and/or to the
center of the page. Objects can be aligned horizontally, vertically, or both. This command can also be
used to align both left and right (and/or top and bottom) edges, making the object widths (and/or heights)
match.

To align the selected objects:

Griginal Unalignad Objects This is the "before" picture for the following Align examples. The
original location is indicated by a dashed outline in the examples.

& & To Align Edges
Luft Right Click on the Left, Right, Top, or Bottom checkbox, depending on
. which edge you want to align, then click the OK button.
. When aligning edges, all objects are aligned with the outermost
Top Botom object. For example, when aligning left edges, all objects are

aligned with the one whose left edge is the farthest to the left.

& To Align Centers

Click on the Horizontal Center, Vertical Center, or both Center
checkboxes, depending on how you want the objects aligned, then
e O click the OK button.

Verlical Bath When aligning centers, all objects are aligned to the midpoint
between the leftmost and rightmost (or topmost and bottom most)
edges of all of the selected objects.

Harlzantal

. . To Align Corners
TopLaft  Top Right Click on the Top or Bottom and Left or Right checkboxes,
depending on which corner you want to align, then click the OK

. . button..

Bottom Latt. Bettam Right As when aligning edges, objects are aligned to the outermost
edges associated with the corner.



. . To Align an Edge and a Center
Click on Horizontal Center checkbox and Top or Bottom, or click

La#t Centar Might Cenger

. on the Vertical Center checkbox and Left or Right, depending on
. how you want the objects aligned, then click the OK button.
Genter Top  Center Baitom Edges and centers are aligned as described previously, and

shown in the example.

0 To Match Sizes
Lot & Right To match sizes horizontally, click on both the Left and Right
checkboxes, then click the OK button.
. . To match sizes vertically, click on both the Top and Bottom
Top & Botlom Bt checkboxes, then click the OK button.

The size of the widest/tallest object is used as the final size.
Smaller objects are stretched to the final size. When matching
sizes, objects are repositioned as when aligning to centers.

& i To Align to the Center of the Page

Click the Align To Center Of Page checkbox, click the desired
edge(s) or center(s) to align to the center of the page, then click
the OK button. If no edges or centers are selected, then the
centers of the selected object(s) are aligned to the center of the

. page.
. The center of the page point acts like another object being

aligned, only it won't move. The selected edges, centers, or
corners of the selected objects are moved to line up with it.

“Bufora® Edy=
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A few representative examples are shown to the left.

Set Spacing

The Arrange|Set Spacing command can be used to precisely set the spacing of drawing objects.
Spacing can be horizontal or vertical with respect to either edges or centers.

To set the spacing of the selected objects:

1. Select Axis
Edgo-To-Edge Spacing Select Horizontal to set spacing "across" and Vertical to set

- spacing "up and down".

2, Select Measurement Method

Certer-To-Ceantar Spacing Select Edge-To-Edge to get an even amount of white space
between objects, select Center-To-Center to get consistent object
spacing regardless of object size (see example to the left).

3. Select Distance

Select Space Evenly to get even spacing while leaving the end
objects where they are. Enter a distance to get objects spaced a
particular distance apart.

Lock



Unlock

Hide

The Arrange|Lock command "locks" the selected objects so that
they cannot be selected in the normal way, nor can they be edited.
This is handy when working in a cluttered area of a drawing to
temporarily prevent repeated selection of the "wrong" object.

To select a locked object for unlocking, hold down the Ctrl key
while clicking on the object. When a locked object is selected,
special selection handles are displayed (see example on the left).

To unlock the object, use the Arrange|Unlock command.

See the Format|Layers command for a more sophisticated method
of managing complex drawings.

The Arrange|Unlock command undoes the effect of the Arrange|
Lock command.

To select a locked object for unlocking, hold down the Ctrl key
while clicking on the object.

The Arrange|Hide command makes the selected objects disappear. They cannot be selected or edited,
and will not appear when the area of the drawing where the were is redrawn. This is handy when
working in a cluttered area of a drawing to temporarily prevent repeated selection of the "wrong" object, or
to temporarily prevent repeated redraws of an object that takes a while to redraw.

To make the hidden objects reappear, use the Arrange|Show All.
See the Format|Layers command for a more sophisticated method of managing complex drawings.



Show All
The Arrange|Show All command undoes the effect of all previous Arrange|Hide commands.



Format Menu

Colors

Line Style

Fill Style

Texture Style
Character Style
Paragraph Style
Page Setup
Layers

Convert To Curve
Convert to Polyline
Simplify Polyline



Colors

The Format|Colors command is used to set the colors of the selected object(s), or of the Default Style if
nothing is selected.

Each object has a Line color, two Fill colors, and two Texture colors. Some of the colors may not matter
for certain objects, depending on the current object style.

To set text colors, see the Format|Character Style command.

Related Topics:

Selecting a Custom Color

Selecting a Palette Color

Customizing the Color Palette

Setting Object Colors - Alternate Methods



Selecting a Custom Color
There are three ways to select a custom color in  the Color dialog:

1. Using the Color Wheel and Luminance samples.
2. Using Red/Green/Blue values.
3. Using Hue/Saturation/Luminance values.

These three methods are closely related. Picking a color one way causes the indicators for the other two
to be updated. The Color sample box shows the selected color. The Solid sample box shows the
nearest color of the 16 basic Windows colors.

- a L
Hue 1. Using the Color Wheel and Luminance Samples
, Pick a color by clicking inside the color wheel. The angle around
Beimratian the color wheel corresponds to a hue value. The distance from
the center corresponds to the saturation value, with pure colors on
Luminanca the outside, and gray at the center.
Pick a lightness/darkness (luminance value) for the color by
. clicking inside the Luminance sample box.
. P e 2. Using Red/Green/Blue Values
eyl Windows uses RGB values internally. Each value ranges from 0
to 255. A particular color is represented by three numbers as
.'?’J'.;‘_ZT 02880} (red, green, blue). RGB is an additive color model, so it works the
e opposite of mixing paints. For example, yellow is red=255 plus
P EERY T RN green=255, or (255,255,0). White is (255,255,255), black is

(0,0,0), grays are other sets of equal values. RGB colors are
often associated with the corners of a cube, as shown to the left.

Increase/decrease RGB values until you get the color you want.

3. Using Hue/Saturation/Luminance Values

The HSL color model corresponds directly to the color wheel
layout as discussed above. Increase/decrease HSL values until
you get the color you want.

Note: A computer display cannot produce every color. For
example, you can't get a really good bright orange. It's not Top
Draw, it's physics.

Selecting a Palette Color

To select a palette color in the Color dialog, scroll the palette up and down until you see the color you
want, then click on it.

The standard color palette is arranged with pure colors near the top, and less saturated, more organic,
and darker colors towards the bottom. Eight hues are arranged from left to right.

The Color sample box shows the selected color. The Solid sample box shows the nearest color of the
16 basic Windows colors.



Customizing the Color Palette

A Top Draw color palette can hold 256 colors. Only 128 are set in the standard color palette. You can
fill in the remaining 128, or redo the whole thing, using the Color dialog.

Before you start redefining the standard palette, it would be a good idea to make an extra copy of the file
topdraw.pal in another directory or on a floppy. You can switch color palettes by replacing the
topdraw.pal in the Top Draw directory before starting Top Draw.

To change a palette color:
1a. Scroll to and select the palette entry to modify by clicking on it.
2a. Select a color as described in Selecting a Custom Color.
- or‘ -

1b. Select a color as described in Selecting a Custom Color, or click the Clear checkbox to erase an
entry.

2b. Hold down the Shift key and select the palette entry to modify.
-then -

3. Click on the Modify Palette button.

4. Click on OK in the confirmation dialog box.

Repeat these four steps to add other colors. Click on OK when done to make the new palette colors
available. The color changes are not saved permanently to the palette file until you exit Top Draw.



Setting Object Colors - Alternate Methods

Using the Format|Colors command is probably the method you will use the least for setting an objects
colors. More convenient methods are:

1. Using the color buttons and palette on the Style Bar.
Using the color palette in the Line Style dialog.
Using the color palette in the Fill Style dialog.

Using the color palette in the Texture dialog.

Clicking twice on a Style Bar color button.

o g~ w N

Clicking the Other button in the Line Style, Fill Style, or Texture dialog.



Line Style

The Format|Line Style command is used to set the Line Style of the selected object(s), or of the Default
Style if nothing is selected.

The upper sample box shows an enlarged view of the current Pen/Start/End Shape. The Line Sample
box shows an example of a line using the current Line Style settings at the same zoom scale as the
current drawing.

The scrollable list of shapes, and the Size, Width and Angle values are associated with either the Pen,
Start, or End shape, depending on which Shapes radio button is currently set.

Line Style options can be modified in any order. Set the options indicated for the desired Line Style:

Related Topics:

Ordinary Colored Lines
Dashed Lines

Arrow Heads and Tails

Calligraphic Pens

Rotating Pens

Defining New Pens and Arrowheads



Ordinary Colored Lines

Q)
O

Ordinary Avarage Linas

To make ordinary colored lines using the Line Style dailog:

Click on the Pen Shapes radio button to set pen attributes.
Select Ellipse as the Pen Shape.

Set the Width to 100% of the height.

Set the pen Size to the desired line thickness.

o M 0 Dbd =

Click on the Start Shapes radio button to set arrow tail
attributes.

Set the line start shape to None.

Click on the End Shapes radio button to set arrow head
attributes.

Set the line end shape to None.
Make sure the Rotating Pen checkbox is off.

Pick a color from the color palette, or click on the Other
button and use the Color dialog..

10. Select the solid line at the top of the list of dashes.

Dashed Lines
.-.::::“-:-:-“:::: To make dashed lines using the Line Style dailog:
:::-:T-:T:: 1. Click on the Pen Shapes radio button to set pen attributes.
2. Select a Pen Shape from the scrollable list.
3. Set the pen Size, Width and Angle as desired.
4. Select a dash style from the list of Dashes.
5. Increase/decrease the Dash Length as desired.
Arrow Heads and Tails
’/, Aline can have zero, one, or two endings. Both endings can be
e either a head or a tail depending on the shape you pick. Line
- - endings are chosen using the Line Style dailog.
. A To add an arrow head:
? a 1. Click on the End Shapes radio button to set arrow head

attributes.
2. Select an arrow head shape from the scrollable list.
3. Set the arrow head Size and Width as desired.
To add an arrow tail:

1. Click on the Start Shapes radio button to set arrow tail
attributes.

2. Select an arrow tail shape from the scrollable list.

Set the arrow tail Size and Width as desired.



Calligraphic Pens

CQ”; fﬂ L To create calligraphic effects using the Line Style dailog, make a
a f z, big, skinny, angled, non-rotating pen:

iy, 1. Click on the Pen Shapes radio button to set pen attributes.
%, J 2. To set the Pen Shape, select a shape from the scrolling
list.

3. Set the pen Size to a suitably large value.
4. Set the pen Width to a small value.
5. Set the pen Angle as desired.

6. Make sure the Rotating Pen checkbox is off.

To change the line color, pick a color from the color palette, or click
on the Other button and use the Color dialog.

Some interesting effects can be achieved by making calligraphic
lines that are also dashed. Calligraphic lines can also have
arrowheads and tails.

Rotating Pens
% g . Rotating pens can be used to create unique effects not possible
i £ ggﬁﬁ( with other draw programs. The most interesting results are
- e achieved using a wide dashed line with a rotating pen.
{::} :.-_-‘é‘ To create rotating pen effects using the Line Style dailog:
1. Click on the Pen Shapes radio button to set pen attributes.

Select a Pen Shape from the scrollable list.
Set the pen Size to a suitably large value.
Set the pen Width as desired.

Set the pen Angle as desired (usually 0).

L

Set Dashes and Dash Length as desired.
7. Make sure the Rotating Pen checkbox is on.

Add an arrowhead and tail, and change the color if desired.

Defining New Pens and Arrowheads

Pens are stored in a symbol file called pens. tds in the Top Draw directory. Arrowheads and tails are
stored in a symbol file called arrows . tds in the Top Draw directory. Pen and arrowhead symbols are
drawn just like any other shape, then added to a symbol file using the Shape Palette dialog.

General Guidelines for Pen and Arrowhead Symbols

1. Always use the vanilla Line Style, namely 0 point, black,
elliptical pen, non-rotating, non-dashed.

2. Always use the vanilla Fill Style, namely solid white, and
no texture.



3. The initial size of the symbol you draw doesn't matter, but
keep it simple.

4. When adding your symbol to the symbol file, give it a
unique descriptive name.

: - Special Rules for Pens
.o 1. Pens must consist of a set of closed shapes. The outline
origin of each closed shape must be drawn in a clockwise
Yo direction to get the expected result. If drawn
- counterclockwise, it will look inside-out when used in a
line.

2. Set the origin (the center of rotation) near the center of the
pen shape, or the center of the set of shapes. The origin
point is where the pen "attaches" to the line.

g Special Rules for Arrows Heads and Tails
- 1. Arrow heads must be drawn pointing to the right.
A Origin 2. Arrow tails must be drawn pointing to the left.

3. Set the origin (the center of rotation) vertically centered in
the arrow head or tail, and towards the left side of the
origin shape. The origin point determines the vertical position
of the arrowhead with respect to the line endpoint, and is

where the "shaft" ends.

4. The rightmost point on the shape determines the
horizontal position of the arrowhead with respect to the
line endpoint.

Fill Style

The Format|Fill Style command is used to set the Fill Style of the selected object(s), or of the Default
Style if nothing is selected.

Fill Styles only apply to closed shapes. You can change the Fill Style of open shapes, but nothing will
happen.

To set the Fill Style, first select a Fill Type (None, Solid, Linear, Radial, or Conical) by clicking on the
appropriate icon. Then, set the Fill Style attributes of interest:

Horizontal and Vertical Offset
The center point for Radial and Conical fill can be moved relative
Offsut (0,0) Gfset [25,26) to the object center. The offsets are specified as a percentage of

the object bounding rectangle width/height. Increase the offsets
to move the center right/up. Decrease the offsets to move the
center left/down.

l - Angle

The angle of Linear and Conical fill can be changed to represent
a particular lighting angle or other effect. Increase the angle to
rotate the fill pattern clockwise, decrease it to rotate counter-
clockwise.

Angle 0° Angle 207



Gradient Steps
- The number of color steps can be changed for all types of gradient
fill. For smoother looking transitions, but slower drawing,
increase the number of steps. For abrupt transitions or striped
effects, decrease the number of steps.

Edge Pad

Linear and Radial fill can be "padded" on the outside edges so
that the color transition occurs over a narrower band. This is
needed when filling many different shapes since the fill pattern is
generated with respect to the bounding rectangle of the shape
rather than the visible object edges.

Fill Colors
To set Fill Style color(s):

20 Steps 4 Steps

Edge Pad 0% Edge Pad 60%

Click on the Color 1 or Color 2 radio button to choose which color
to set. None fill has no colors, Solid fill has one color, all three
gradient fills have two colors.

To select a color, scroll to and click on the desired color in the
color palette. To select a custom color, click on the Other button
and use the Color dialog.

Texture Style

The Format|Texture Style command is used to set the Texture Style of the selected object(s), or of the
Default Style if nothing is selected.

Texture Styles only apply to closed shapes. You can change the Texture Style of open shapes, but
nothing will happen.

To set Texture Style:
1. Choose a Texture Type (None, Pattern, or Tile) by clicking on the appropriate radio button.
If you chose None, no other options apply. Click OK.

Select a particular Pattern or Tile texture from the list provided.

Set the Texture Style attributes of interest:
Patiern:Lines
Line Size/Symbol Size
For Pattern textures, this setting controls the width of the pattern
lines. Most Pattern textures a single line width. For Tile textures,
i Pt 2P this setting controls the width and height of the tile symbol.

Pattern: Lines

Increase for wider lines, decrease for narrower lines.

Spacing

For Pattern textures, this setting controls the distance between

pattern lines. For Tile textures, this setting controls the spacing
05" Spacing 17 Spacing between the tile symbols.

Increase for wider spacing, decrease for narrower spacing.



Pattern:Spokes

Offsel (0.0} Offset (50,50)

Tike:Hexagons

Angles (0,90) Angles (0,120
Tile:Dlamaonds
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Character Style

The Format|Character Style command is used to set the Character Style of the selected text, or of the

Default Style if no text is selected.

]

Origin Offset

For row/column textures, this setting controls the row/column
starting location and is specified in current units. For circular or
radial textures, this setting controls the center point of the circle
and is specified as a percentage of the object bounding rectangle
width/height.

Increase the offsets to move the center right/up. Decrease the
offsets to move the center left/down.

Line Angles
For row/column textures, this setting controls the angle of the rows
and columns.

Random
Turn this setting on to randomize the distance between pattern
lines or tile symbols. Turn this setting off for regular spacing.

Colors

Most pattern textures have one color (except for Crosshatch).

Tile textures have two: Color 1 for the outline, and Color 2 for the
middle of the tile shape. The fill color(s) can also be set.

To set a texture or fill color, click on the appropriate color radio
button, then scroll to and click on the desired color in the color
palette.

To select a custom color, click on the Other button and use the
Color dialog.

Set the Character Style attributes of interest:

Arial

Courier New
Times New Roman
6 Point

8 Point

10 Point

12 Point
14 Point

Bold
Italic

Underline

o
Mormal
W id e

Font
To change fonts, select a new one from the drop-down list. True
Type fonts provide the best results. Vector fonts are also listed.

Points
To change the font size, select a new size for the drop-down list, or
enter the desired size in the edit box.

A "point" is a unit of measure used in typesetting. 1 point = 1/72
inch.

Style
Set the desired style option(s) by clicking on the appropriate
checkbox(es).

Character Width
To change the character width, select a width from the drop-down
list, or select Custom from the drop-down list and enter the desired



width in the edit box.

Condensed .
Normal Spacing
Expanded To change the amount of space between characters, select a

spacing value from the drop down list, or enter the desired spacing
in the edit box (positive values for expanded, negative for
condensed).

Note: Negative spacing values may cause the characters to
overlap.

Super/Subscript

To change the relative vertical position of characters, select the
desired position from the drop down list, or enter the desired offset
in the edit box (positive values for superscript, negative for
subscript).

BUPeTgoript
suhscript

Color
To set the color of selected text, click on the Style Bar Fill Color 1
button and select a color in the Style Bar Color Palette.

Paragraph Style

The Format|Paragraph Style command is used to set the Paragraph Style of the selected text, or of the
Default Style if no text is selected.

Set the Paragraph Style attributes of interest:

Single 112 Dauble

et s T Line Spacing

spaced
His dhls. pemilonka) To set the spacing between lines in a paragraph, select a standard
Nk thia. 5 spacing from the drop down list, or select Custom from the drop
frue il down list and enter a value in the edit box. Custom spacing is

specified as a percentage of the line height.

For a single line of text, like a label, the spacing must be set to
Single for vertical alignment to work properly.

Harlzanial Vernlosl

Lef Texy Top Teal Alignment

.'L'”.I.I.' ! To set the Horizontal and Vertical alignment of text within the

[ bounding shape, select the desired alignment style from the drop
Batinz Tay down list.

Left  First Ling Righkd
L Indentation
When in the Coutse To set the Left and Right indentation of lines within the bounding
pf mumen ovanis shape, enter the desired values. To set the indentation of the
une people lo didiale First line relative to the Left indentation, enter the desired offset.

e pelicical bands w hich
have connected 1hem

Indentation is measured from either the top or the bottom of the
characters, whichever is closer to the container outline. So, the
apparent indentation will be greater when the sides are highly
angled.

Tep
Spacing
o am im fhw m Sl To set the Top and Bottom margins of the text within the top and
fuf (e m Il pasagraphs bottom of the container, enter the desired values.

Fut xome space ai the botiom

[ he lat pAmgzaph To set the spacing Between paragraphs, enter the desired value.

When text is vertically aligned to the Top, the Top spacing value



determines where the first line of text will appear, and the Bottom
spacing value determines the "cut-off" point for making extra text
disappear. The reverse applies for Bottom aligned text. For
vertically centered text, the Top and Bottom spacing values
determine where the vertical center of the container is, and the top
and bottom cut-off points.

Hint: Increase the top/bottom spacing value if a word is broken
because the container is too narrow at the top or bottom.

Page Setup

The Format|Page Setup command is used to set the page size and orientation for the current drawing.
To setup the drawing page:

1. Choose a page Orientation by clicking on either the Portrait or Landscape radio button.

2. Choose a Page Size from the drop down list, or select Custom from the drop down list and enter
the Width and Height for the page.



Layers

The Format|Layers command is used to add, delete, arrange, and set the edit and show modes of layers
in the current drawing. By dividing a complex drawing into layers, you can easily control which parts of
the drawing can be edited, and which are visible.

Set the options of interest to configure the layers of a drawing:

To Set the Layer Edit Mode
Click on the appropriate Edit mode radio button to control which layers can be edited:

* Single Layer Only objects in the current layer
* Behind Current  Only objects in or behind the current layer.
e All All drawing objects can be edited.

Note: The Edit mode depends on the Show mode - only visible layers can be edited.

To Set the Layer Show Mode
Click on the appropriate Show mode radio button to control which layers are displayed:

¢ Single Layer Only objects in the current layer
* Behind Current  Only objects in or behind the current layer.
e All All drawing objects are displayed.

To Add a Layer

1. Select the layer you want the new layer to go in front of by clicking on its Select checkbox. All
other Select checkboxes must be off.

2. Click on the Insert button.

To Name a Layer
Edit the text in the Name field.

To Move a Layer
1. Select the layer you want to move by clicking on its Select checkbox. All other Select
checkboxes must be off.
2. Click on the Forward/Back buttons to change the layer position.

To Combine Layers
1. Select the layers you want to combine by clicking on the Select checkboxes. All other Select
checkboxes must be off.
2. Click on the Combine button.

Combining layers moves the drawing objects from two or more layers into a single layer, and deletes the
extra layers. Objects are moved into the front-most layer of those selected.

To Delete a Layer
1. Select the layer you want to delete by clicking on its Select checkbox. All other Select
checkboxes must be off.
2. Click on the Delete button.
Warning! Deleting a layer deletes all of the drawing objects in it!

Drawing with Layers

The number and name of the current layer are shown in the Status Line. New drawing objects are
always added to the front of the current layer. The layer that the currently selected object belongs to is
also shown in the Status Line. To move existing drawing objects between layers, use the Arrange

Forward and Arrange|Backward commands, or Edit|Cut and Edit|Paste along with the Layers Buttons.






Convert To Curve

The Format|Convert To Curve command converts any selected
polyline or ellipse objects to Bezier curve objects. This is useful
when you want to create smooth curves in an object that was
initially created as a polyline.

-

The example shows a rectangle that was converted to Bezier
curves then given a rounded top and bottom by setting node
attributes to make the handles show up and using the Node Tool
to move the handles.

Related Commands:
To control how closely a Bezier curve tracks a polyline during
conversion, set the Bezier Curve Tracking parameter using the

Options|Lines & Curves command.

Convert to Polyline

The Format|Convert To Polyline command converts any selected
Bezier curve or ellipse objects to polyline objects. This is useful
when you want to create jagged edges in an object that was
initially created as a Bezier curve.

&

The example shows an ellipse that was converted to a polyline,
then made to look "pointy" by editing the polyline nodes.

Related Commands:

To control the number of points in the resulting polyline, set the

Bezier Curve Resolution parameter using the Options|Lines &
Curves command.

The number of points also depends on the current zoom scale.

Zoom in for more points.

Simplify Polyline

The Format|Simplify Polyline command simplifies any selected

polyline objects by removing points that fall in the middle of nearly
Simplifiad Folyling straight edges. This is useful when you want to reduce the

number of points used to represent a polyline to simplify editing.

Related Commands:

To control how closely the simplified polyline tracks the original,
set the Simplifier Tracking parameter using the Options|Lines &
Curves command.

Node Menu

Add
Delete
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Align
Attributes



Add

The Node|Add command adds a new node to a polyline or Bezier
curve. New nodes can be used to make new corners or curves in
aline.

Before After

To add a node:
1. Select the line to be modified with the Node Tool.

2. Position the point of the Node Tool on the line where you want the new node to go and click the
left mouse button to set the Selection Point.

3. Perform the Node|Add command, or type Ins (Insert key).

Hint: If the Add command is grayed in Step 3, the Selection Point is either too far from the line, or you
selected an existing node.



Delete

The Node|Delete command deletes nodes from a polyline or
Bafors Afier Bezier curve. Deleting nodes will smooth or straighten a line.

To delete a node:
1. Select the line to be modified with the Node Tool.
2. Select the node to be deleted with the Node Tool.
3. Perform the Node|Delete command, or type Del (Delete key).

Note: When deleting a node in a Bezier curve, Top Draw adjusts the handles of the adjacent nodes to
keep the curve in roughly the same place.



" The Node|Join command connects two endpoints together. If the
endpoints are from the same line, the line becomes closed (upper
example). If the endpoints are from different lines, the lines
become connected (lower example).

HRafare Allar
To join two nodes:
1. Select the line(s) to be modified with the Node Tool.
2. Select exactly two end nodes to be joined.
3. Perform the Node|Join command, or type Alt+J.

Hint: If the Join command is grayed in Step 3, either the wrong number of nodes is selected, or the
nodes are not endpoints.



Break

The Node|Break command breaks a line at a selected node, or at
the Selection Point. If a closed line is broken, it becomes an open
line (upper example). If an open line is broken, it becomes two

Bafore aftar lines (lower example). The nodes at the break point are moved a
little so that the node highlighting is visible.

To break a line:
1. Select the line to break with the Node Tool.

2. Position the point of the Node Tool on the line where you want to break it and click the left mouse
button to set the Selection Point or select a node.

3. Perform the Node|Break command, or type Alt+B.

Hint: If the Break command is grayed in Step 3, either the Selection Point is too far from the line, or no
node is selected.



Align

Harizantal
"

Wartical

Bath

Before

To align nodes:

After

The Node|Align command aligns the selected nodes horizontally
and/or vertically, and aligns Bezier curve node handles as well.

By aligning nodes, you can make part of an outline horizontal or
vertical and align nodes in different outlines to each other.

You can also make parts of two outlines "match" by aligning
corresponding nodes both horizontally and vertically, and aligning
handles if the outlines are Bezier curves.

1. Select the object(s) containing nodes to be aligned with the Node Tool.

o > 0N

Select the nodes to be aligned with the Node Tool.
Perform the Node|Align command to display the Align Nodes dialog.
Click on the desired alignment options.

Click OK to align the selected nodes.



Attributes

The Node|Attributes command is primarily for setting Bezier curve node handle attributes, but it can also
be used to set the location of both polyline and Bezier curve nodes. To determine the type of an object,
select it and read the Status Line.

To set node attributes:
1. Select the object(s) containing the node(s) to be modified with the Node Tool.
2. Select the nodes to be modified with the Node Tool.

3. Perform the Node]|Attributes command, or double click on a selected node, to display the Node
Attributes dialog.

Set the desired attribute options (see discussion below).

Click on OK to modify the selected node(s).

Mo Handlas Hamndlas

. A Curve Before/Curve After
g A Bezier curve node may have zero length handles. If both
Before Aftar nodes on a curve segment have zero length handles, that

segment is a straight line. To make the handles show up so you
can bend the segment, click on Curve Before (for the handle
towards the start node), and/or Curve After (for the handle away
from the start node). When in doubt, click both checkboxes on.

Note: You must select the node again after setting the attribute(s)
to make the handles show up.

i T Same Angle
. The curve passing through a node may be smooth, or it may form
Smaath Carner a corner (or "cusp"). To ensure that the curve will be smooth, set

the Same Angle option on. To allow a corner at the node, set the
Same Angle option off.

1.0 e When the Node Tool is used to move a node handle that has the
- Same Angle attribute on, the opposite handle for the same node
will automatically move to maintain a smooth curve through the
node. If there is only one handle, the handle will stay aligned with
the opposite line segment. If the Same Angle attribute is off, the
opposite handle does not move.

. .. . Same Length

| o i The curve passing through a node may have different curvatures
Same Length Mo on opposite sides of the node if the handles are different lengths.

To ensure that the curves are symmetric near the node, set the
Same Length option on. This will automatically set the Same
Angle option on if it isn't already. It will also automatically set the
Curve Before and Curve After options on if they aren't already.
To allow asymmetric curves, set the Same Length option off.

When the Node Tool is used to move a node handle that has the
Same Length attribute on, the opposite handle for the same node
will automatically move to maintain the same angle and same
length.

Note: The curve segments on either side of a node with the Same
Length attribute on won't really by symmetric unless the adjacent
nodes and near node handles on either side of it are in mirror-
image locations as well.



Location

Set the location of the selected node(s) entering the desired
location in ruler coordinates. If one node is selected, the location
will be used as a new absolute location for the node. If more than
one node is selected, the location will be used as an offset to the
current node locations.

Options Menu

Display

Fast Redraw
Select Tool
Draw Tool
Zoom Buttons
Lines & Curves



Display
Set Display Options

The Options|Display command lets you customize the appearance of several aspects of the Top Draw
user interface:

Button Sizes

Buttons come in three sizes. The main reason for this is so that the buttons will fill up roughly the same
amount of space on the screen in 640x480, 600x800, and 1024x768 display modes. The Small size is
the default for standard 640x480 VGA displays, Medium is the default for 600x800, and Large is the
default for 1024x768 (or higher) super VGA displays. To use a different button size, click on the radio
button for the desired size and click OK.

Note: Top Draw maintains three button size settings, one for each of three display resolution ranges. If
you change display modes, you will have to set the button sizes for that mode separately.

Colors

So you don't like battleship gray all over your screen? Change it. Click on the color sample box for the
display element that you want to change. This will cause the Color dialog to be displayed. Select a color
in the usual way.

Hint: When picking the color for a screen element that contains black text, try to use a light color that is
not "grainy" looking.

Fonts

You can customize the font used for displaying text on the Style Bar, the Rulers, and the Status Line.
Changing the font size also changes the size of the window that contains it, since the window is sized so
that the text will fit (within limits). So, if you want skinnier rulers or a taller Status Line, change the font.

To change a display font:

1. Click on the button for the display element that you want to change. This will cause the Font
dialog to be displayed.

2. Select the desired font, font style, and size. You can type a number in the edit box to select font
sizes that do not appear in the list.

3. Click OK to exit the Font dialog.
Click OK to exit the Display Options dialog.



Fast Redraw
Fast Redraw On/Off

The Options|Fast Redraw command lets you get faster screen updates at the expense of using
additional memory. The extra memory is for a bitmap that is used to draw objects more quickly "behind
the scene". The actual memory required depends on you current display resolution and number of
colors.

If there is a checkmark by the Fast Redraw command in the Options menu, Fast Redraw is on.
Using Fast Redraw:
1. Turn the option on by performing the Options|Fast Redraw command.

2. If you get an error message, you don't have enough memory. No further action is required. If
you add memory to you system, or close some other applications, you can try again.

3. If you don't get an error message, check available memory using the Help|About Top Draw
command. If you still have some elbow room, leave the Fast Redraw option on. If not, turn it
off by performing the Options|Fast Redraw command again.

Top Draw will remember the setting. Just set it once, and forget it.



Select Tool
Set Select Tool Options

The Options|Select Tool command lets you customize the Select Tool in several different ways.
The following options can be modified:

Nudge Step

You can move the selected object(s) horizontally and vertically using the arrow keys. The Nudge Step
setting determines how far the object moves with each key press. Increase Nudge Step to move objects
farther and faster. Decrease Nudge Step to move objects more precisely using the arrow keys.

Control Angle Step

If you hold down the Ctrl key while rotating an object with the Select Tool, the object will jump between
certain angles. The Control Angle Step setting determines the angular distance between steps.  You
can set it to any value. Values that divide evenly into 90 are recommended.

Contact Distance

When you press the left mouse button while using the Select Tool, Top Draw checks to see if there is an
object nearby to select. The Contact Distance setting determines how close the mouse must be to an
object to be considered "touching". Increase this value in order to more easily "grab" an object.
Decrease it in order to more precisely select the right object in a cluttered area of the drawing.

This setting doesn't make much difference for filled objects since you can grab them anyplace that is filled
in. It makes the most difference when grabbing thin lines, or outlines of unfilled objects, or when working
in the wireframe display mode.

Guideline Snap

When an object is moved close enough to a guideline, it jumps into contact with it. The Guideline Snap
setting determines how close an object must be to a guideline to be snapped into contact. Increase this
value if the guidelines don't seem "sticky" enough. Decrease it if they seem too sticky.

Max Outline Points

When a simple object or object control point is grabbed using the Select Tool, its outline appears. When
a complex object is grabbed, a bounding rectangle appears. The Max Outline Points setting
determines how complex the outline can be before a rectangle is used instead. Increase this value if you
have a fast computer and outlines redraw quickly when you move an object with the Select Tool. This
will allow you to see the full outline of more complex objects during a move. Decrease this value if you
have a slow computer and outline redraw is noticeable.

Duplicate Offsets

When the selected object(s) are duplicated, the new copies appear a short distance away from the
originals in the drawing. The Horizontal Offset and Vertical Offset settings determine how far and in
what direction from the original the duplicate will appear. You can set these to whatever value you like.
Avoid making the offset so large that the duplicates are placed way off the drawing page.



Draw Tool
Set Draw Tool Options

The Options|Draw Tool command lets you customize the Draw Tool in several different ways. The first
group of options control how the Draw Tool behaves while you are drawing new lines. The second set
controls conversion of new input.

The following options can be modified:

Freehand Point Spacing

When you move the mouse while drawing a freehand line with the Draw Tool, Top Draw waits until the
mouse has moved at least some minimum distance before adding another point to the line. The
Freehand Point Spacing setting determines how far the mouse must move before the point is added.
Increase this setting to get smoother looking freehand lines. Decrease it for more precision and detail

Join/Close Distance

When you start drawing a line with the Draw Tool, Top Draw looks to see if you there is an existing line in
the drawing to connect the new line to. When you end drawing a line with the Draw Tool, Top Draw
looks to see if you have created a closed shape, or if there is an existing line in the drawing to connect to.

The Join/Close Distance setting determines how close another endpoint must be to the new endpoint to
be connected. Increase this setting to make it easier to connect to existing lines or make closed shapes.
Decrease this setting for more precise control over what gets connected.

Control Angle Spacing

When creating a straight line segment with the Draw Tool, you can hold down the Ctrl key to force the
line to fall on only certain angles. The Control Angle Spacing setting determines how closely spaced
those angles are. You can set it to any value. Numbers that divide evenly into 90 are recommended.

Note: This is the same parameter as the Select Tool Options Control Angle Step. Changing either
one changes both.

Multiple/Single Segment
Use the Multiple Segment setting to draw long lines consisting of multiple freehand and straight line
segment combinations. Double click or hold down the Shift key to finish a line.

Use the Single Segment setting to draw a lot of short freehand lines or single straight lines. Just
release the left mouse button to finish a line.

Note: If you hold down the Shift key while drawing a line, the current multiple/single segment mode
temporarily switches to the opposite mode.

Grid Freehand Input
Turn this option on to get a chunky or block effect when drawing freehand lines. When this option is on,
freehand points are forced to fall on snap grid lines. For normal drawing, turn it off.

Simplify Polyline

To reduce the number of points used to represent a new shape, turn on the Simplify Polyline option.
Before a new line is added permanently to the drawing, points that fall on the middle of a nearly straight
line will be removed. This is usually a good idea unless you need an extremely detailed outline. If you
want to keep every input point, turn this option off.

See Also:

e The Format|Simplify Polyline command.
e The Simplifier Tracking parameter in the Line & Curve Options dialog dialog.

Convert To Curves
To add a new line to the drawing as a Bezier curve, turn this option on. To add the new line as a polyline,
turn this option off.



See Also:

e The Format|Convert To Curves command.
e The Bezier Curve Tracking parameter in the Line & Curve Options dialog.



Zoom Buttons
Set Zoom Button Functions

The Options|Zoom Buttons command lets you customize the operation of the zoom buttons. Each
zoom button has two functions, one for the left mouse button and one for the right.

To swap the left/right function assignments for a zoom button, click on either of the "off" radio buttons
associated with the zoom button.




Lines & Curves
Set Line and Curve Conversion and Display Options

The Options|Lines & Curves command lets you control conversion of new polylines and Bezier curves,
and control Bezier curve display.

To following parameters can be modified:

Original Polyline
- . Simplifier Tracking
The polyline simplifier is used when new lines are created with the
Draw Tool and the Simplify Polyline option is on, and when the
Format|Simplify Polyline command is used. The simplifier
reduces the number of points used to represent a polyline by
removing points in the middle of "nearly" straight lines.

Semplifior Tracking = 3 Pizels

Senplifier Tracking = 18 Pixeis

The Simplifier Tracking setting determines how close to a nearly
straight line a point must be to be removed. Increase this value to
get fewer points in the result, but a looser match to the input.
Decrease it to get a closer match to the input, but more points in
the result .

Owiginal Falyline

Bezier Curve Tracking

Polylines are converted to Bezier curves when new lines are
created with the Draw Tool and the Convert To Curves option is
on, and when the Format|Convert To Curves command is used.
The Bezier curve does not exactly match the original polyline
since corners and straight lines are smoothed and rounded.

Bazier Curve Tracking = 5 Piosls

Bazier Curve Tracking = 3% Pizaks

The Bezier Curve Tracking setting determines how closely the
Bezier curve tracks the input polyline. Increase this value to get
smoother output, but a looser match to the input. Decrease it to
get a closer match to the input, but a less smooth result.

Bezier Curve Resolution

Increase this setting for faster redraw, but draft quality output
(visible corners in rounded objects). Set to 1 for proof quality
output.

Window Menu

Tile
Cascade

Arrange Icons
Close All

Switch To Drawin



Tile

The Window|Tile command resizes and arranges all of the
currently open drawing windows side by side. If there are many
open windows, they are arranged in columns and rows.

Cascade___

The Window|Cascade command resizes and arranges all of the
currently open drawing windows. The windows are overlapped so
that each title bar visible.

Arrange Icons

The Window|Arrange Icons command lines up the icons for all minimized drawing windows.



Close All

The Window|Close All command closes all of the drawing windows.



Switch To Drawing

The file names of the currently open windows are listed at the bottom of the Window Menu. To switch to
another drawing, select the one you want from the list.

If there are more than nine open drawings, the last entry in the Window Menu will be More Windows.
To select a window that is not one of the first nine, select More Windows, pick the window you want in
the scrollable list presented in the Select Window dialog, then click OK.



Help Menu
Contents

Road Map
How To Use Help

Technical Support
About Top Draw



Contents

The Help|Contents command display the table of contents for Top Draw Help. You can click on a topic
name to jump to that topic. To get to the Contents topic quickly while in Top Draw Help, click on the
Contents button in the Windows Help button bar.




Road Map

Introduction
Overview

Copyright Notice

Disclaimer of Warranty

License Agreement

Release Notes

How This Manual Is Organized

Typographical Conventions

How to Contact Top Software
Technical Support
ASP Ombudsman

Feature Requests/General Feedback
Art Contest

Getting Started

System Requirements
Installation

Running Top Draw
Registering

What is Shareware?

Why Register?

Here's What You Get!

Ordering - USA

Ordering - UK

Ordering - French-Speaking Europe
Ordering - German-Speaking Europe
Ordering - Australia

Ordering - Scandinavia
Other International Orders

Learning Top Draw
How to Learn Top Draw

Learning By Doing
Using Help

Top Draw Basics

Screen Layout
Dialog Box Conventions
Drawing Elements

Tutorial Exercise

Page Setup

Drawing Mountains
Drawing with Layers
Drawing a Forest
Drawing a Pond
Drawing a Cabin

ABit o' Text

Earth and Sky

What have you learned?



Top Draw Windows
The Title Bar

The Menu Bar

The Style Bar

Character Style Buttons
Paragraph Style Buttons
Font Selection

Line Style Buttons

Fill Style Buttons
Texture Style Buttons
Color Palette

Line Sample

Fill and Texture Sample

The Tool Window

The Drawing Window

Page

Desktop

Rulers
Ruler Grid
Snap Grid
Guidelines

Units Button

Scroll Bars

The Status Line

Top Draw Tools
The Select Tool

Selecting Objects
Moving Objects
Sizing Objects
Rotating Objects
Slanting Objects
Stretching Objects

The Node Tool

Node Editing Basics
Polyline Node Editing

Bezier Curve Node Editing
Ellipse Node Editing
Line/Curve Type Conversions

The Text Tool

Creating Paragraph Text
Text Editin
Text Styles

The Draw Tool

Draw Tool Options
Drawing Straight and Freehand Lines



Line, Fill, and Texture Styles
The Shapes Tool

Drawing a Shape
The Shape Palette

The Notes Tool
The Zoom Buttons
The Layer Buttons

Top Draw Menus

File Menu

New

Copy Style
Set Style

Duplicate
Select All

View Menu

Redraw Now
Wireframe

Style Bar

Status Line
Rulers

Ruler Grid
Guidelines

Notes

Paragraph Marks
Snap to Grid
Snap to Guidelines
Ruler Setup

Arrange Menu

Forward
To Front
Backward
To Back




Set Spacing
Lock

Unlock
Hide
Show All

Format Menu

Colors

Line Style

Fill Style

Texture Style
Character Style
Paragraph Style
Page Setup
Layers

Convert To Curve
Convert to Polyline
Simplify Polyline

Node Menu

Options Menu

Display

Fast Redraw
Select Tool
Draw Tool
Zoom Buttons
Lines & Curves

Window Menu

Tile
Cascade

Arrange Icons
Close All

Switch To Drawin
Help Menu
Contents



Registering
Technical Support
About Top Draw

Keyboard Commands
Menu Command Accelerators

Text Editing Keyboard Commands
Drawing Keyboard Commands

Glossary of Terms




How To Use Help

The Help|How To Use Help command provides instruction on using the Help system. It is provided as
part of Windows. This is a good place to start if you are a new Windows user or you are unfamiliar with

Windows Help.



Tutorial

The Help|Tutorial command displays the tutorial topic of the Top Draw Help system. This is a good
place to start if you are just learning how to use Top Draw.



Windows

The Help|Windows command provides information about each of Top Draw's subwindows. Look here for
information about the Style Bar, Status Line, Drawing Window, and other windows.



Tools

The Help|Tools command provides information about each of Top Draw's tools, i.e., that column of
buttons on the left hand side of the screen that are involved with most interactive editing functions.

Look here for information on the Select Tool, Node Tool, Text Tool, Draw Tool, Shapes Tool, Notes Tool ,
Zoom Buttons, and Layer Buttons.




Menus

The Help|Menus command provides information about each of the Top Draw menu commands. Look
here to find out what a particular menu command does.



Keys

The Help|Keys command provides information about Top Draw keyboard commands. Look here for
information about keystroke equivalents of menu commands, and keyboard-only commands.



Registering

The Help|Registering command provides information about how and why to register your copy of Top
Draw.



Technical Support

The Help|Technical Support command provides information about using the technical support services
available to Top Draw users. Look here if you encounter a problem while using Top Draw for information
on how to make best use of the technical support services.



About Top Draw

The Help|About Top Draw command displays information about:
1. The unregistered user run mode, or the registered user name.
2. The name of the distributor for your copy of the program.
3. Available memory, disk space, and system resources.

Click OK when you are done reviewing the information.



Menu Command Accelerators

The following keyboard commands can be used to execute the associated menu commands. Note that
keypresses are also listed in menus to the right of the menu command name as a reminder.

Key Press Command

ESC Interrupt redraw
F1 Context sensitive help.

Shift + F1 Help|Contents
F3 File|Save

Alt + F4 File|Exit
Shift + F4 Window|Tile
Shift + F5 Window|Cascade

Insert Node|insert
Ctrl + Insert Edit|Copy
Shift + Insert Edit|Paste
Delete  Edit|Delete or Node|Delete (depending on context).
Shift + Delete  Edit|Cut
Alt + Bksp Edit|{Undo
Alt + Shift + Bksp Edit|Redo

Ctrl + A Arrange|Align
Ctrl +B Bold selected text (toggles)
Ctrl+B Arrange|Backward
Shift + Ctrl + B Arrange|To Back
Alt+B Node|Break
Ctrl+C Edit|Copy Style
Shift + Ctrl + C Edit|Set Style
Ctrl +D Node|Duplicate
Ctrl +F Arrange|Forward
Shift + Ctrl + F Arrange|To Front
Ctrl + G Arrange|Group
Shift + Ctrl + G Arrange|Ungroup
Ctrl +1 Italicize selected text (toggles)
Ctri+ M Arrange|Merge
Ctrl +R View|Redraw Now
Ctrl +S Arrange|Set Spacing
Ctrl+T Arrange|Transform
Ctrl +U Underline selected text (toggles)
Ctrl + W View|Wireframe

Text Editing Keyboard Commands

Typing Text
Moving the Text Caret
Deleting Text



Typing Text

Insert

Bofore  AftedBofora New text is added by typing the desired characters. In insert
Ovarwrite mode, the text caret is a vertical line and a new character is
Before  Afted] inserted at the text caret. In overwrite mode the text caret is a

box and a new character replaces the character currently
highlighted by the text caret. The text caret moves to the right as
new text is entered.

To toggle between insert and overwrite mode, press the Insert

key.
Moving the Text Caret

. Arrow Key Function

Left Left one character.

" Right Right one character.
i Up Up one line.
Y Down Down one line.
Word Ctri+Left Left one word.
Word,, Ctrl+Right Right one word.
Edit Key Function

wgfitari al lna Home Start of line.
End of Inm,, End End of line.

Page Up Start of paragraph.

Page Down  Eng of paragraph.

Deleting Text

If a block of text is selected when you type new text, paste new text, press the delete or backspace key,
or perform the Edit|Delete command the selected text is deleted.

The following keys can also be used:
Key Function
Backspace Delete character to left of text caret.
Delete Delete character to right of text caret.

Drawing Keyboard Commands

The following keyboard commands are and command modifiers available during the indicated drawing
operations.

Key Press Command
(Spacebar) Toggle between Select Tool and other tool.

< Nudge selected object left.



Bksp
Ctrl

Shift
Alt

Nudge selected object right.

Nudge selected object up.

Nudge selected object down.

Erase last line segment while drawing a line with the Draw Tool.
When sizing - make width equal height.

When rotating - rotate in steps.

When editing ellipse node - make chord.

When sizing - size from the center.

When sizing - size proportionally

Glossary of Terms

Bezier Curve

Bitmap
Click On

Current Drawing

Current Selection

Default Style

Dialog Box
Guideline

Mouse Cursor
Node

Origin Point
Perform
Polyline

Ruler Origin
Selection Point

Text Caret



Bezier Curve

A Bezier curve is a type of smoothly curving line. Each curve segment is defined by two nodes, which
are the segment endpoints, and two handles which determine how far and in what direction the curve

segment is bent near each node.



Bitmap

A bitmap is a two-dimensional grid of dots. Pictures are created by assigning a color to each dot.
Common ways of creating bitmaps include "paint" programs, "screen grabber" programs, and scanners.



Click On

To "click on" an object on the screen: 1) Move the mouse cursor over the object. 2) Press and release
the left mouse button.



Current Drawing

The current drawing is the drawing that is currently being edited. It is the only visible drawing if the
drawing window is maximized, the topmost drawing window if the drawings are cascaded, and the active
drawing window if the drawings are tiled.



Current Selection

The current selection is either one or more drawing objects, or a block of text. The Select Tool is
normally used for selecting drawing objects. The Text Tool or Notes Tool is used to select a block of

text.



Default Style

The Default Style is used to set object style attributes whenever new objects are created. Default Style
attributes are displayed in the Style Bar when there is no current selection.




Dialog Box

A pop-up window typically used to enter values or select alternatives for a set of related options or
parameters. Also referred to as a "dialog".



Guideline

A guideline is a tool for interactively aligning drawing objects. Guidelines appear in a drawing as solid
light blue horizontal or vertical lines. A guideline is "pulled from a ruler" by pressing the left mouse button
while the mouse cursor is in the ruler, moving to the desired position in the drawing, and releasing the left

button.



Mouse Cursor

The mouse cursor is the shape on the screen that moves as you move the mouse. The shape of the
mouse cursor depends on the window that the mouse is in and the function being performed.



Node

A node is an endpoint of a polyline or Bezier curve line segment. A polyline node is simply a point. A
Bezier curve node has two "handles" that control the curvature of attached curve segments.




Origin Point

The origin point is the center of rotation when an object is rotated with the Select Tool. The origin point
is also used for determining how a shape used as a pen, arrow head, or arrow tail, aligns to the line it is
on. When an object is selected with the Select Tool, the origin point of an object is marked by a "+" with
a circle around it.



Perform

To perform a menu command: 1) Move the mouse cursor over the menu name in the Menu Bar. 2) Press
the left mouse button. The menu will appear. 3) While holding the left mouse button down, move the
mouse cursor over the command name in the menu. 4) Release the left mouse button.



Polyline

A polyline is a type of line constructed from simple straight line segments. Each straight line segment is
defined by two nodes, which are the segment endpoints.



Ruler Origin

The ruler origin is the point that is at the zero position on both the horizontal and vertical rulers. When
the mouse cursor is positioned at the ruler origin, the coordinates displayed on the Status Line will be

(0.00, 0.00).



Selection Point

The selection point is the point on the drawing where the left mouse button was last clicked. It is marked
by a bright pink "+". It is used to mark the current position for pasting, importing, and node operations.



Text Caret

The text caret is the blinking line or box that appears when the text tool is used to create new text or is
clicked in a selected object. The text caret marks the point where new text will be placed when you start

typing.



We welcome comments and suggestions about how to improve Top Draw!



We don't like bugs either! Please help us help you by following these guidelines.



On-line files can be found in your Top Draw directory.



The How To Use Help command in the Help Menu provides an introduction to Windows Help.



The tutorial takes about 45 minutes to complete.



Use the New command in the File Menu to open a new file.



A dialog box is sometimes referred to as simply a "dialog".



The page setup can be changed at any time. But, it is often more convenient to set it when you start a
new drawing.



Layers can be added, moved, renamed, or deleted at any time.



If you prefer, you can just read the instruction in the Top Draw Install dialog box after Step 3.



You don't need to stop install to switch to another Windows program.



The install program will only create one new directory level.



Decompressing and copying the files only takes a few minutes.



You will double-click this icon to launch Top Draw from the Program Manager.



Selecting a directory works the same as in the Windows File Manager.



Selecting a directory works the same as in the Windows File Manager.



If the file already exists, you will be given the opportunity to change your mind before it is overwritten.



The number of copies is saved between prints.



The print scale is saved between prints.



Title page options are saved between prints.



The Windows Control Panel can be used to install or uninstall printers.



The Node Attributes dialog can also be accessed by double-clicking on a node.






